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Exercise 0 — SIFT Lab Installation

Objectives

e Install and prepare your lab workstation for digital forensic analysis for the week.

e Move the evidence files gathered during IR evidence collection phase to our analysis platform for
further scrutiny.

Exercise Preparation

1. Install VMware Workstation/Fusion or VMware Player from vmware.com.
e hitps://www.vmware.com/products/workstation
e https://www.vmware.com/products/player
e http://www.vmware.com/products/fusion
2. Install RedLine on your Windows Host or VM.
e |located on your USB under \SIFT-Lab~Install\redline.

® You might need to install .NET before the installation. The install for the FULL version of .NET is found in
\SIFT-Lab-Install\redline.

e |t is CRITICAL that you install and ensure RedLine functions before the beginning of Section 2 in the
course. Do not simply wait to install it minutes prior to needing it for the RedLine exercises.
e |tis also highly recommended that you install RedLine on your host system instead of your virtual
machine to increase processing power during memory analysis.
e You can check to see if Redline works correctly by simply executing it and getting to the “Main Screen.”
3. Ifyou are using a Windows host, install 7zip.
e located on your USB under \SIFT-Lab-Install\7zip.
4. Copy and install the SIFT workstation.
e located onyour USB under \SIFT-Lab-Install\SIFT\SIFT 3 — FORS08.zip.

» This PC » FOR508 (D) » SIFT-Lab-Install » SIFT

~ Name

{, SIFT 3.- FOR508.zip
Virtual Machines
I Home Share View
~ 4 | » ThisPC » Documents » Virtual

ideos A
o | SIFT 3 - FOR508.zip
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What Is on the USB?

1. The USB contains the data from the four systems potentially involved in the intrusion breach.
2. The name of each of the directories is listed by:
e Operating System
o System owner
e |P address
e OS~User-IP
e Example: win7-32-nromanoff-c-drive

. win7-32-nromanoff-10.3.58.5

. win7-64-nfury-10.3.58.6

. win2008R2-controller-10.3.58.4
xp-tdungan-10.3.58.7

3. In each of the directories, you will find three additional directories.

FORS508-USB (F:) » win7-32-nromanoff-10.3.58.5

N
Name
win7-32-nromanoff-c-drive
win7-32-nromanoff-incident-response

win7-32-nromanoff-memory

FIR)
a. c-drive directory
e This is the location of the collected hard drive images.
e On the win7-32-nromanoff-c-drive directory, you will also see a precooked
directory.

e The precooked directory is where we have some data preformatted in case certain tools take
too long to process the data. Each exercise that uses precooked data will let you know.

FORS08-USB (F:) » win7-32-nromanoff-10.3.58.5 > win7-32-nromanoff-c-drive
~
Mame Date modified
precooked 5/23/2015 8:12 AM
win7-32-nromanoff-c-drive.E01 8/18/2015 12:19 PM
IR win7-32-nromanoff-c-drive.td 8/18/201512:21 PM

b. Incident Response directory
o This is the location of data collected during Incident Response on each system.
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FOR508-USB (F:) > win7-32-nromanoff-10.3.58.5 » win7-32-nromanoff-incident-responseg

al
Name Date modified

fY] autoruns-win7-32-nromanoff.csv 4/9/2012 10:27 AM

¢. Memory directory
e This is the location of the memory image collected during Incident Response.

FOR508-USB (F:) > win7-32-nromanoff-10.3.58.5 » win7-32-nromanoff-memory
~
Name Date modified
D win7/-32-nromanoff-memory-raw.001 4/9/2012 12:28 PM
win7-32-nromanoff-memory-raw.txt 4/9/2012 12:28 PM
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Exercise - Setting up your Lab - Preparation for the Week

1. Tweak the settings of your VMware configuration to allow for more memory and processor power as
your system will allow. Note: Do not ever increase it beyond the maximum recommended settings.
2. Launch VMWare Player, Fusion, or Workstation:
1. File ->Open.
2. \Path-To\Virtual Machines\SIFT3 -~ FOR508\SIFT3 - FOR508.vmx

3. Upgrade your virtual machine if you can: VM -> Upgrade or Change Version. (Follow the wizard.)

] SIFT 3 - FOR508 - VMware Workstation - O m
File Edit View VM Tabs Help
B~ 0] [l a = ¥

| & SII;I’ 3 - FORS508
{4ISIFT 3 - FOR508

B Power on this virtua! machine
EVEdit virtual machine settings

3 Upgrade this virtual machine &

~ Devices
B Memory 4GB
3 Pracessors 8

“iHard Disk (SCST) 500 GB

ZHard Disk 2 (SCS1) 1000 GB (Persistent)
T#Network Adapter NAT

US8 Controller  Present

$iSound Card Auto detect

B Display Auto detect

~ Description
Type here to enter a description of this
virtual machine

Figure 1 - Update Version to Latest

4. Adjust Memory -> Select “Edit Virtual Machine Settings” -> Select Memory.

NOTE: Do not give your VM more than half of your machine’s memory. If your machine slows down as
a result, reduce the amount of memory allocated to the VM.
Virtual Machine Settings

Hardware Options

Device Summary | Memory

SN P ol Spedify the amount of memory allocated to this virtual
3 Processors 8 machine. The memory size must be 2 multiple of 4 MB.
S Hard Disk (SCSI) 500 GB -

3 Hard Disk 2 (SCSI) 1000 GB (Persistent) Memory for this virtual machine: 4096 © MB
FiNetwork Adapter NAT

USB Controller Present 64 GB

¢ Sound Card Auto detect 32G8

HEDisplay Auto detect 16 GB
8 £ Maximum recommended memory
« {Memory swapping may

beyond this size.
268 occur beyond this size.)

6 M|

168 5956 MB

1218 o Recommended memory
6B 1024 M8

128 MB

Figure 2 - Edit Memory Configuration
© 2016 Rob Lee Exercise 0-4




5. Power on your virtual machine.
1. Press “Power on virtual machine” and select “I copied it.”

e This virtual machine may have been moved or copied.

1n order to configure certan management and networking features, VMware
Waorkstabon needs to know if you moved this virtual machine or if you copied it.

1If you don't knowe, answer "I copied it”.

Imovedit
O lcopiedit

6. Start your SIFT VMware Workstation in VMware Workstation.

] SIFT 3 - FOR508 - VMware Workstation - U |
File Edit View VM Tabs Help
- 2hd ho} g BDaEH

& SIFT 3 - FORS08
HISIFT 3 - FOR508

B Powar on this virtual machine @

ETEdit virtual machine settings

~ Devices
s Memory 4GB
O Processors 8

& Hard Disk (SCS1) 500 GB

=Hard Disk 2 (SCSI} 1000 GB {Persistent}
B#Network Adapter NAT

SUSB Controller  Present

¥ Sound Card Auto detect

S Display Auto detect

~ Description

Type here to enter a description of this
virtual mactune
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7. Loginthe VMware machine.
> LOGIN = sansforensics

» PASSWORD = forensics
siftworkstation O Elen ) 536AM O

sansforensics ®

Password

Guest Session

Sl FT v3 DSHAL FDRENSICS § INCIOINT RESPONSE

8. Double-click the SIFT Workstation icon and browse to the /cases directory. (Click Filesystem Icon
->/cases.)

upoate manager g % 1) W) HISHAM X S3NSTOTensis T b

Host-Computer-
Drive

mount_points

.

SANS DFIR.pdf log2timeline-
cheatsheet.pdf

memory-forensics-
cheatsheet.pdf

TES
&g

il windows-to-unix-
sift-cheatsheet.pdf cheatsheet.pdf.

S DFIR

@ - DIGITAL FORENSICS B INGIDENT RESFONSE
8

Evidence of Poster.  Find-Evil-Poster.pdf
pdf
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9. Check your initial Incident Response Data -- Change directories to the /cases directory in your
terminal and run the file listing command “1s.” You should see all the directories here.

@ & & sansforensics@siftworkstation: fcases

sansforensics@siftworkstation:~$ cd /cases/
sansforensics@siftworkstation:/cases$ 1s

sansforensics@siftworkstation:/cases$

10. You have successfully prepped your SIFT Workstation for FOR508 — Advanced Incident Response for
the first part of the week!
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STARK RESEARCH LABS

Exercise 1.1 - APT Intrusion Scenario

APT Scenario Written, Designed, and Created by Rob Lee

APT Team - John Strand and Timothy Tomes
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COMPANY INFORMATION:

Stark Research Labs is a government-sponsored laboratory that researches specialized metal alloys
and bio engineering capabilities. Lately, SRL has been tasked to find the secret and once-lost alloy
formula for VIBRANIUM-Alloy. The lead researcher, Timothy Dungan, has been making progress,
and it looks like with the help of others he was finally able to replicate the formula. Timothy Dungan
has been working tirelessly on trying to find the missing formula for the past two years.

DIRECTOR OF LAB DESCRIBES AN APT THREAT - MARCH 27, 2012

M. Hill is the current SRL-LABS Director.

Date: 27 Mar 2012 07:08:48 -0700 (PDT)

From: Maria Hill <mhill.shield@yahoo.com>
Reply-To: Maria Hill <mhill.shield@yahoo.com>
Subject: APT Threat

To: Department Heads SRL

All Research Department Leads:

Our threat Intelligence Sharing and Analysis Center (ISAC) partnership has shared
that an APT group called HYDRA has taken specific interest in metallurgy research as
of late. They have compromised similar companies and research entities.

As far as we can tell, HYDRA APT group is sponsored by a nation state advanced
threat who targets specifc companies and organizations who specialize in metal and
bio-engineering research similar to ours. The exhibit similar quality in capability
compared to the “COMMENT CREW” or “APT1” This nation has started to infiltrate many
sectors in almost every industry stealing economic information, intellectual
property, and targeting key executives with spear phishing attacks.

The ISAC has released a specific IOC for our Hunting/Incident Response teams to use
to help identify potential presence in our organization. Also, their intent is
targeting breakthrough research, so we will likely begin taking a closer look at
systems and management involved in the vibranium research project.

Metals Research Subnet: 10.3.58.X

If you have any questions, please reply to this email.

-MH

Note: APT1 REPORT is found on your USB under \documents\Threat Intelligence
Reports\MANDIANT APT1 REPORT.pdf.

_————r———————— e e e e
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10 DAYS AGO - MARCH 27, 2012
THREAT INTELLIGENCE REPORT - New Malware (HTTPPUMP) in use by APT Group HYDRA

Description: Members of this family are full-featured backdoors that communicate with a Web-based
Command & Control (C2) server over HTTP port 80 using XMLRPC over HTTP for encoding,.
Features include interactive shell, gathering system information, uploading and downloading files,
and creating and killing processes. Malware in this family usually communicates with a hard-coded
domain using XMLRPC over HTTP on port 80. Some members of this family rely on runkey
launchers to establish a persistence mechanism for them. Several variants use $USER%\Local

Settings\Temp or $USER% \AppData\Local\Temp as working directories; additional malware
artifacts may be found there.

Basic Threat Indicator Provided for HTTPPUMP

o MD5=¢c4b0458c04abdaa773348c2668212b45
o OR
= Filename = a.exe or b.exe or c.exe
= AND
¢ (Compile Time =2011-10-13 04:19:53 or 2011-10-19 02:39:12)
e File Size = 9216 or 9245
= AND
e Directory location = \Temp
e Strings inside malware = httppump
e \CurrentControlSet\Services\Netman\domain
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ONE WEEK AGO - MARCH 31, 2012 @ 16:11:16

From "Timothy Dungan" Sat Mar 31 16:11:16 2012

From: "Timothy Dungan" <SMTP:TDUNGAN@STARK-RESEARCH-LABS.COM>
Subject: Test Success - Alloy Combination

To: 'mhill.shield@yahoo.com'’

Cc: 'nromanoff@stark-research-labs.com'

Date: Sat, 31 Mar 2012 16:11:16 +0000

We have finally replicated the long lost secret of Vibranium-Iron alloy.

After months of testing we have found that the secret to combing the alloy was
accidentally discovered when a lab student (Peter of Horizon Labs) stopped by. See
attached report. Next steps?

-Timothy

e e ———— e T e =
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EXCITED, TIMOTHY DUNGAN POSTS PUBLICALLY ABOUT THE FIND!

PUBLIC TWEET ON 31 MAR 2012

Timothy Dungan & Reply T3 Retweet W Favonte - Open
FINALLY We found it!!! Thanks to PETERI!

—_— e e e e e e e T e e
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FAST FORWARD - APRIL 6, 2012 @5PM
The SRL Threat Hunting Team begins hunting for the APT group hydra. Your mission?

e Answer the key question: Have we been breached?
¢ Begin/perform Incident Response if a breach is detected.

_— ... —s—ss s e
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Research Labs

.2 STARK Research Labs .. World Leader

{ Research Labs specializes in metals, alloys, and biotech research and STARK Research Labs is a world leader in the fight to protect our chuldren against head
development for the application of defensive and offensive technologies for the North injuries. Our new extremely light bicycle helmets with patented lightweight metal alloys
American and European counter-terronsm sectors and for the Department of Advanced have saved cauntless lives in b accidents worldwide
Projects (DoAP) under contract from the American Advanced Research Projects -- Omni
Labs Division (AARP-GLDY, and Harbmger Corporation, Novamber is transparent aluminum awarcress month!

Through our innovative use of cutting-edge atloy and biotech technologies, we seek a
more peaceful and safer world.

.: Not Just Metal and Alloy Research

‘The brotech subfamily of research 1s Iooking at beetles, cockroaches, and the hom toad to examune their properties that help defend and protect these unique creatures from attack. Our
research grants into shark and prehistoric piranhas have made exciting breakthroughs in cancer research over the past 2 years. Combining biotechnology and atloy research, we invented
bulletproof cotton that have protected police and milttary personne] worid-wide.

.: The Future

The future of bioteck, alloy, and metals research is here! Protecting our children and our troops worldwide.
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Enterprise network with more than 1,000 users and systems.

The target of the analysis will begin looking at the subnet involved in the vibranium research, which

also contains a domain controller for that segment of the network.
A few of the key systems on that subnet include:

e 10.3.58.4 Win2008R2 Domain controller

e 10.3.58.5 Win7-SP1-32bit N. Romanoff Workstation — Vibranium Program Manager

e 10.3.58.6 Win7-SP1-64bit N. Fury Workstation — SRL Management

e 10.3.58.7 WinXP-SP3-32bit Timothy Dungan Workstation — Vibranium Lead Researcher

Additional Key Internal Networks
10.3.58.X — Workstation and Lab Stations
10.3.16.X — Workstation and Lab Stations

FalconlIl - VPN Concentrator
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SRL-LABS BASE DOMAIN INFORMATION

Full auditing is turned on per recommended guidelines.

Users are restricted to being users (cannot even install a program if they wanted to).
Windows 2008R25P1 domain controller.

Systems installed and have real software on it that is used (Office, Adobe, Skype, Tweetdeck,
E-mail, Dropbox, Firefox, and Chrome).

Fully patched as of 6 April 2012 (today). Patches are automatically installed.

Enterprise Incident Response agents (F-Response Enterprise).

Enterprise A/V and -capability (McAfee Endpoint Protection— Antivirus, Antispyware, Safe
surfing, Antispam, Device Control, Onsite Management, and Host Intrusion Prevention
[HIPS]).

Network Using HBSS (Host Based Security System) per the DOD recommendations.
Firewall allowed inbound 25, 80, 443 and outbound 25, 80, 443 only.

Users have been "using" this network for more than a year prior to the attack. That way it has
the look and feel of something real. These users have set up social media (yes, they are on
Twitter, and you might be friends with them), e-mail, Skype, and so on. Each character user
has a backstory and a reason to be there working.

Rsydow is the sole domain administrator.

SRL-HELPDESK account is local admin account with a shared password.

Local Admin User (SRL-Helpdesk) was found on each system with the same password.
Not every user has migrated to Win7 and Win2008. We do still have some legacy WinXP
systems.

Most of the employees telecommute from home to the lab. The VPN concentrator is located on
the \ \FALCONIII system. Most users RDP into their systems from the VPN.

— e ———™— e e
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Exercise 1.2 - Mounting Evidence Using SIFT

Objectives

1. Mount an acquired disk image into the SIFT workstation so that you can see the files and folders and
begin analysis of the system.

2. Learnthe process for examining and manipulating compressed images, such as split EO1s, using the
SIFT workstation.

3. Learn alternative ways of mounting disk images using imageMounter.py and mountwin.

Exercise Preparation

1. Start your SIFT VMware Workstation in VMware Workstation.
2. Loginto the VMware machine.

» LOGIN = sansforensics

» PASSWORD = forensics

Exercise — Step-by-Step Guide

1. Elevate your privileges to root.

$ sudo su -

2. Change directories to the /cases/win7-32-nromaocff-c-drive/. When you run the “Is”
command below, take note of how many and the sizes of the “E01, E02, E03” files in the directory.

# cd /cases/win7-32-nromaoff-c-drive/

# 1s -1h

root@siftworkstation:/cases/win7-32-nromanoff-c-drive# ls -1lh

total 9.1G

drwxrwxrwx 3 sansforensics sansforensics 4.0K May 23 2015 00
-rwxrw-rw- 1 sansforensics sansforensics 9.1G Aug 18 2015
-rwxrw-rw- 1 sansforensics sansforensics 1.9K Aug 18 2015

3. Mount the win7-32-nromaoff-c-drive.E01 image files in the /mnt/ewf_mount directory.
Note the result of this command will combine the compressed expert witness images into a single raw
image. The ewfmount command will always name this file “ewfl.” The ewfmount command will
combine the (E01, E02, E03, and such if present) files together and uncompress them via the running

mount process. When you run the “Is” command below, take note of the file size of the uncompressed raw
image.
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EO1 to Raw

Mount EO1 using e /mnt/ewf/ Directory will now contain a raw dd/raw image
ewfmount

e # ewfmount image-name.EOl /mnt/ewf/

# ewfmount win7-32-nromanoff-c-drive.EO0l /mnt/ewf mount/
# cd /mnt/ewf _mount

# 1s -1h

root@siftworkstation:/# cd /cases/win7-32-nromanoff-c-drive/
root@siftworkstation:/cases/win7-32-nromanoff-c-drive# ewfmount win7-32-nromanoff-c-drive.E01 /mnt/ewf_mount
ewfmount 20140608

root@siftworkstation:/cases/win7-32-nromanoff-c-drive# cd /mnt/ewf_mount
root@siftworkstation: /mnt/ewf_mount# 1s -1h

total 0

-r--r--r-- 1 root root 25G Jun 7 18:35 ewfl

4. Mount the win7-32-nromaoff-c-drive raw image found in the /mnt/ewf_mount directory on the
/mnt/windows mount directory.

mount —-oloptions] device directory

[Useful Options]
-0 Use the following options separated by commas --

no spaces

ro, mount as read only

loop, mount on a loop device {used for image files)

noexec, do not execute files from mounted partitions

offset=byte num, if mounting a physical drive you can use the
offset option to have it mount at X bytes
into the physical disk

show_sys files, show NTFS volume metafiles

streams interface=windows use alternate data streams

Figure 1 Mount Command Options and Explanations

# mount -o ro,loop,show_sys files,streams_interface=windows ewfl
/mnt/windows_mount/

# cd /mnt/windows mount

# 1s

root@siftworkstation:/mnt/windows_mount# 1s

110
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Alternative Exercise — Using Alias “mountwin” to Reduce Typing and to Make Mounting Easier

root@siftworkstation: /# alias

alias mountwin='mount -o ro,loop,show _sys files,streams_interface=windows'

1. Unmount the previously mounted files and remount using the alias of the mount command shown above
using “mountwin” instead.

# umount /mnt/windows_mount

# cd /mnt/ewf mount

# mountwin ewfl /mnt/windows mount
# cd /mnt/windows_mount

# 1s

Alternative Exercise — Using imageMounter . py to Make it Easier to Mount Physical and Logical Disks

Mounting disk images, although easy to do, is still a multistep process using the SIFT Workstation. To shorten
this step, Kevin Breen updated his imageMounter.py script to mount logical and physical disks automatically to
the location of your choice. The exciting thing about the code is that it handles both GPT- and MSDOS-based
physical disk structures and portioning schemes. As a result, an individual no longer needs to spend precious
time pulling out calculators performing simple but time-consuming operations to simply mount a partition
inside the SIFT workstation.

imageMounter . py points at the physical/logical disk structure as the first argument, and the second is the
location in the /mnt directory where the analyst would like to mount the disk image.

If the analyst/responder is mounting a logical disk structure, then he would add the (-s) option to the file. If

the file is contained as an EO1 file, it will detect the format and perform the necessary mounts needed to
adjust.
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Usage: imageMounter.py [options] image name mnt point

[USEFULL OPTIONS}
Single partition in image
Just display the information
Use ewfmount to mount EO0 Evidence Files
Mount Bitlocker Drive with Recovery Key

-k RECOVER KEY Bitlokcer Recovery Key
+  Python Auto-mounter \::/ Physical Logical
+ Mounts a variety of partition e —
types across volume types 8
(see list on right) EE MSDOS GPT
« Time saver from tricky i g
partition challenges 53 BITLOCKER EO1

Figure 2 imageMounter.py Command Options and Explanations

In the end, | can see a tool such as imageMounter.py helping analysts avoid being annoyed slightly by having
to do this manually. imageMounter . py will go a long way in speeding up the mounting process.

1. Unmount the previously mounted files and remount using “imageMounter.py.”

umount /mnt/windows_mount

umount /mnt/ewf mount

cd /cases/win7-32-nromaoff-c-drive/

imageMounter.py -s win7-32-nromaoff-c-drive.E0l /mnt/windows mount

cd /mnt/windows_mount

H = = = = I

1s
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Exercise 1.3 — CTI - Indicator Creation and

Examination

Objectives

1. Install and launch 10C Editor on your Windows workstation.

2. Examine I0C Editor’s interface and examine default APT1 “Comment Crew” indicators.

3. Build your own I0C based on the information provided by the government agency that contacted
you.

4. Use Boolean logic and different operators to ensure your I0C is properly configured.

Exercise Preparation

» Install Mandiant I0C Editor from your USB on your Windows Host (or VM) in the \SIFT-Lab-
Install\IOC Editor folder.

JFASIET-Lab-InstaiNOC Edito [

»

A [ Name

i3 Mandiant 10Ce.msi ﬁ

» If prompted -- you might need to install .NET 3.5 or greater before the installation. The install for the FULL
version of .NET is found in \SIFT-Lab-Install\I0C Editor\DOTNET
a. NOTE: If you have Win10 and are encountering installation issues, there is a guide at end of exercise

» Launch Mandiant I0C Editor (Win 7 and Win 8 shown below).

. Mandiant o
: verywhere
I¥ Mandiant 10Ce
B Mandiant I0Ce User mandiant (6188
I MessageOps
. Microsoft Office 2013 \ [g Mandiant 10Ce <,
4 Back ; z
% tAandiant 1I0Ce User Guide
Search programs ang o J T
e, logo_mandiant_intelligent_respo...
A ) . W logo_mandiant_intelligent_respo...
Windows 7

» Open “IOC Directory” \SIFT-Lab-Install\IOC Editor\APT1 - IOCS\.
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e 10Ce 2.2.0 - FASIFT-Lab-install\lOC Editor\APT1 - I0CS S A= E—
File Search Tools Help

Name Created Updated Souce “ | Name: |AURIGA (FAMILY) Type Refere

Appendix E - APT1 File Hashes  2013-02-1006:11:53Z2 201302-10 13 00.00Z Mandiant

AURIGA (FAMILY) 20130210 06:11,532  2013-02-101300:00Z Mendiant puhocs| Wandar m i::cdoor

BANGAT {FAMILY) 2013-02-1006:11:532  2013-02-10 13:00:00Z Mandiart GUID: |d2240090-afsd-466e-a39c-54add5bo8a13 famiy APT1

BISCUIT (FAMILY) 20130210 06:11:532  2013-02-10 13.00:.00Z Mandient Created: |2013-02-10 06:11-532 famiy AURIGA

BOUHCER (FAMILY) 20130210 06:11:532  2013-02-10 13:00.00Z Mandant o

CALENDAR (FAMILY} 20130210 06:11:53Z 20130210 13:00.00Z Mandiant Modfied: (2013-02-10 13:00:00Z

COMBOS (FAMILY) 20130210 06:11:53Z2  2013-02-1013:00.00Z Mandiant i

COOKIEBAG (FAMILY) 2013:02-1006:11:53Z 20130210 13.00:002  Mandiant mﬁa P y e BANGAT bacdens The

DAIRY {FAMILY) 2013021006153 20130210 1300007 Mandert | e AUEGAmE w5 mw wy?ﬁ%wmmfm.mm;mmgmc e o,

GDOCUPLOAD (FAMILY) 20130210 06:11:532 20130210 13.00:00Z Mandart | (e system and registry moddications, spawning interactive command shels. pedorming process

GETMAIL FAMILY) 2013-02-10 06:11:532  2013-02-10 13:00.00Z Mandiart injection. logging off the cument user or shuiting dovin the local machine. The AURIGA mahware v

GLOOXMAIL (FAMILY) 2013-02-10 06:11:53Z2 20130210 13:00:002 Mandiart

GOGGLES {FAMILY) 2013021006:11:532 20130210 13:00.002 Mandant  |Add: AND OR ltem - 5

GREENCAT (FAMILY) 2013-02-10 06:11:532  2013-02-10 13:00.00Z Mandiant oR PR

HACKSFASE (FAM".Y) 2013-02-10 06:11:53Z2  2013-02-10 13.00.00Z Mandiant file Corpile Time is 2009-06~23T00:29:112

HELAUTO {FAMILY) 2013-02-1006:11:532  2013-02.10 13:00:00Z  Mandiant File Cempile Time is 2009-02-04T03:35:452

KURTON {FAMILY) 2013-02-10 06:11:332  2013-02-10 13.00:002 Mandiant File Compile Time is 2010-03-01108:26:01Z

LIGHTBOLT (FAMILY) 20130210 06:11::532  2013:02-10 13:00:.00Z Mandiant File Compile Time is 2010-11-06T13:54:412

LIGHTDART (FAMILY) 2013-02-1006:11:53Z  2013-02-10 13:00:00Z2 Mandiant AND

LONGRUN (FAMILY) 2013-02-10 06:11:53Z  2013-02-1013.00:00Z Mandiart File Size is 174083

MANITSME (FAM]LY) 201302110 06:11:53Z2  2013-02-10 13:00:00Z Mandiant File Ceompile Tipe is 2009-04-23710:00:90Z TO 2005-04-22716:00:

MAPIGET (FAMILY) 2013-02-1006:11:532  2013-02-10 13:00:002  Mandiart = AUD

MINIASP (FAM]LY) 201302-1006:11:532  2013-02-10 13:00:00Z Mandiant File FIInfo Versicn Info LegalCopyright is (C) S3/Diamend Mult

NEWSREELS (FAMILY) 201302-1006-11:537  2013-02-10 13:00:00Z Mandient File FEInfo Versicn Infe Language is Znglish (United States)

SEASALT FAMILY) 20130210 06:11:532  2013-02-10 13:00:00Z Mandiant File PZIafo Versien Info FileDesceiptien is RieDrzv Usb Driver

STARSYPOUND FAMILY)  2013-02-1006:11:52Z 2013-02-10 13:00:00Z Mandiant g o2 e L . -

SWORD (FAMILY) 20130210061153Z 20130210 1300002 Mandiant L TEInie emon It S enme (I Dotmvmeaw
File PEinfo Versicn Info Internallame is riodrv3Z

TABMSGSQL (FAMILY) 2013-02-10 06:11:532 20130210 13:00.00Z Mandiart Loa

TARSIP-ECLIPSE (FAMILY)  201302-1006:11:53Z 20130210 13.00:002  Mandiant File FEInfo Version Info ProductName is S3/Diamond Multimed

TARSIP-MOON (FAMILY) 20130210 06:11:53Z  2013-02-10 13:00:00Z  Mandiant File PZInfo Versicn Info Companylame is S3/Diamond Multimed

WARP (FAMILY) 2013-02-10 06:11:532  2013-02-1013:00.002 Mandiant v

WEBCZ-ADSPACE (FAMILY)  2013-02-1006:11:53Z 2013-02-10 13.00.00Z Mandiant £ >

:VEBCZ-AUSOV(FAMILY) 2013-02-10 06:11:532  2013-02-10 13,00.00Z Mandia;n" Save

Loaded 10Cs: 47

Exercise — 10C Familiarization

1.

Spend about 5 minutes browsing the various APT1 indicators and the I0Cs that have been created already.
The main objective is to identify a specific “level of detail” and familiarization with the Boolean expressions
of the various malware families.
Select DAIRY (FAMILY) of malware and step through the IOC ruleset in the lower-right corner.
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Name

DAIRY (FAMILY)

Type Refere ...
Author: Mandiant family DAIRY
GUID zoaazp] | TeAeoe APT
8500aa€b-38834d-48d3-a07d~-d43b0428ddZb hnﬂy APT1
Created: 2013-02-10 0€:11:532 calegory  Backdoor
Modfied: 2013-02-10 13:00:002

Description
Members of this malware family are backdoors that provide file downbading. process listing, process kifing, and reverse shell capabilties
This malware may also add tseff to the Authonzed Applications bist for the Windows Firewa

Add: AND OR item ~

OR

MD5
MD3
Full

et
L

is 895442£722cc0372853353405c297ead
is 8425dcZcli9laail7b3cedldsbI80282
Path contains \temp\updatasched.exe

1)
s M) Nhp N
(o)
b [
3
:
]

Detected Anomalies is checksum is zexo
Compile Time is 2008-01-29T22:52:492
ize 13 1945§

w g ony
VAV
Jos
[

o
-
o

Name is
Name is

Lssavp32Z.exe
HWinverSSL.exe

[
i
n o

TR

[

AND
Aegistry Fath centains Services\Sharediccess\Parametersg\FirewallPoliecy\StandardProfile\ductherizedApplications\Lisst
=-0OR
Regirgctry Text containsg lssap32.exe
Regiscry Text containg winverssl.exe

3. Detail the Boolean Expression I0C language by stepping through the logic. Again, all we would like you to
do here is mainly become familiar with the language.

Exercise — Create an I0C Based on Threat Intelligence Provided by a Government Agency

As a part of the notification, the government agency that notified you also gave you a basic indicator of the APT group
HYDRA that has compromised other locations. Look at the provided information and create an 10C for the indicator:

e Family - HTTPPUMP
e Threatgroup — APT

e Family - HYDRA

e Category — Backdoor

Note: This information is found in a text file (so you can copy the text) called HTTPPUMP . txt in the \SIFT-
Lab-Install\IOC Editor folder.

Description: Members of this family are full-featured backdoors that communicate with a Web-based
Command & Control (C2) server over HTTP port 80 using XMLRPC over HTTP for encoding. Features include
interactive shell, gathering system info, uploading and downloading files, and creating and killing processes.
Malware in this family usually communicates with a hard-coded domain using XMLRPC over HTTP on port 80.
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Some members of this family rely on launchers to establish persistence mechanism for them. Several variants

use %USER%\Local Settings\Temp or %USER%\AppData\Local\Temp as working directories; additional
malware artifacts may be found there.

I0C Provided
e (MD5=c4b0458c04abdaa773348c2668212b45 or Filename = a.exe,b.exe, c.exe)
o AND

= (Compile Time=2011-10-13 04:19:530r2011-10-19 02:39:12)
® File Size = 9216 or 9245
= AND

e Directory location = \Temp
e Strings inside malware = httppump

e \CurrentControlSet\Services\Netman\domain
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Exercise — Build the 10C Template Family

1. Select File -> New -> Indicator.

File | Search Tools Help

New i : » I} Indicator Ctrl+
Open IOC Directory... Ctrl+Q Indicator from

=r
A Save Ctri+S S Window  Ctrl+W

Caveo AN Cahy Chifs €

2. Set Name = HTTPPUMP (Family) .
3. Set Author = SANS Student.

Name: |HTTPUMP (Famiy) b | Type  Reference
Author: |SANS Student h

GUID: 86c197bb-alf9-4dé1-béd5-bc3£as891ats

Created: 2015-03-03 21:45:462

Modfied: 2015-903-03 21:45:462

Description:
4. Right-click the area to the right of the Name and Author location, which should say
“Type/Reference.”

Name: | HTTPUMP (Famiy) | Type  Reference
Author:  SANS Student ‘ :
| Add Group
GUID: 86c197bb-al£9-4d61-b6d5-bc3Za5891azs |
Add Report
Created: 2015-03-03 21:45:462 Add Comment
Modfied: 2015-03-03 21:45:462 Add Category
Descnption: Add Grade
Add Threat Group
Add Other
5. Right-click -> Add Other -> Type = Family, Value = HTTPPUMP.
Edit Reference E
Type: Value:
Family (HTTPPUMP|
| Save || Cence
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6. Right-click -> Add Other -> Type = Family, Value = HYDRA.

. Type:
Family

Edit Reference ﬁ

Nalusioale ol

HYDRA _ ]

7. Right-click -> Add Threat Group -> Type “APT.”

Edit Reference ﬁ‘

| Downloader

| Dropper

1installer

| Keylogger
[Launcher

[ Rootkit

i|Sn3ffer

| Tunneler

Uiy

|Virus

| Browser Helper Object
|Credential Stealer

i Exploit

iGINA Replacement
IMchious PDF
| Password Dumper

9. Copy and paste the description for the malware from the textfile on your USB.

Name: HTTPUMP (Famiy)

Author:  SANS Student

GUID: 26c1370b-a1£8-4d61~bEds-be3fas891aLe ]
Created: 2015-03-03 21:45:462

Modfied: 2015-03-03 21:45:462

Type Reference
Famdy HTTPPUMP
Famiy HYDRA
threatgroup APT

category Backdoor

directories, addiional matware adifacts may be found there

Members of ths family are full featured backdoors that communicates with a Web-based Command 8 Control {C2) server over HTTP port 80 using XMLRPC over HTTP for encoding. Features include
interactive shell, gathering system info. uploading and downloading files. and creating and kifing

on port 80. Some members of this family rely on launchers to establish persistence mechanism forthem. Several vanants use “USER%\Local Settings\Temp or ZUSER\AppData\Locai\Temp as working

processes, Malware in this family usually communicates with a hard-coded domain using XMLRPC over HTTP
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Exercise — Build the 10C Using the Provided Information

1. Right-click 1st “OR” -> Add Item -> File Item -> File MD5 -> Type
“c4b0458c04abdaa773348c2668212b45"

S op : Diskit ' File Filename Changed
' iskltem »

= ddifen / DnsEntrvit File Filename Created
: nsEntryltem »

Add Logic » i File Filename Modified
T IV R COTI TR IS TR Dri\,eﬂtem »

| File Full Path
Email >
File Import Function

EventlLogltem »

) ) File Import Name
FileDownloadHistoryltem  » |

— ' File INode
Fileltem > — —

g : File MD5
FormHistoryltem > | : T

. : File Modified Time
Hiveltem > |
File Name

Heolkltem 'S

2. Right-click 1st “OR” -> Add Item -> File Item -> File Name -> Type “a.exe”

- o= ] | . rie Fiiename Mioditied
— T . Diskitem » .
Add ltem » DneEntrl , File Full Path

e e - — nsEntryltem >

% Add Logic » | . i File Import Function

E | Driveritem > .
| . - File Import Name
| Email > | .

File INode

| EventLogltem » )
. ) ) File MD5
. FileDownloadHistoryltem  » | . o
| - | File Modified Time
|] Fileltem 3 ] —
| - - File Name
[ FormHistoryltem > ‘ - s -
[ ) | File Number of Imported Functions
| Hiveltem > | )
[ File Owner
| Hookitem > | R

3. Right-click 1st “OR” -> Add Item -> File Iltem -> File Name -> Type “b.exe”
4. Right-click 1st “OR” -> Add Item -> File Item -> File Name -> Type “c.exe”
5. Check your work. Your 10C should look like this:

OR
File MD5 is ¢c4b0458c042bdaa773348c266€8212b4s
File Name contains a.exe
File Name contains b.exe
File Name contains c.exe

6. Right-click “OR” -> Add Logic -> Select “AND”
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[ 7&& Logic > 1%_ T ;_\NB_ = __}

File Name cecntains c.el OR

Add item » Bbdaa773348cz6682]

e e e

7. Right-click 1st “AND” -> Add Logic -> Select “OR”

MDS i3 c4b0458c04abdaa773348c2€68212b4
Name cconteins a.exe
Name containg b.exe

Name contains c.exe
Add ltem _> l
Add Logic > |l AND

— B -
Change Logic 4 JL BROR _

8. Right-click 2nd “OR” -> Add Item -> File Item -> File Size -> Type “9216”

" Add ltem

Add Logic
Change Logic

Delete

Prune

Fileé sctzangs conceins h——

I Fileltem ____:j File Shalsum
™ *|  FormHistoryitem » File Sha256sum
’ Hiveltem » . File Size
» Hookitem 4 File Stream Shatsum
Moduleltem » File Stream Sha256sum
Network > File Detected Characteristics

File Detected Signatures

9. Right-click 2nd “OR” -> Add Item -> File Item -> File Size -> Type “9245”
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10. Check your work. Your |10C should look like this:
"l UK

File MDS is c4b0458c04abdaz773348¢c2€68212b45s
File Name contains a.exe
File Name contains b.exe
File Name contains c.exe
AND
OR
File Size isg 8Z1lé
File Size is 8245

11. Right-click 1st “AND” -> Add Logic -> Select “OR”

=} OR
File MDS is c4b0458c042bdaa773348¢c2€€68212b4
File Name contains a.exe
File Name contains b.exe
File Name containa c.exe

& Add ltem » k
I Add Logic X ‘;! AND |
Change Logic » 1_ OR |

12. Right-click 3rd “OR” -> Add Item -> File Item -> File Compile Time -> Type “2011-10-13T04:19:53Z"

¥ile Scrings concaims BI— — 0 ————
@ S | Fileltem > File Certificate Subject
I Additem  » | FormHistoryltem » File Changed Time

Add Logic » Hiveltem » File Compile Time

Change Logic > Hookitem » File Created Time
Moduleltem > File Detected Anomalies

Delete
Network > File Detected Characteristics

Prune
noen File Detected Signatures

13. Right-click 3rd “OR” -> Add Item -> File Item -> File Compile Time -> Type “2011-10-19T02:39:122"

14. Check your work. Your IOC should now look like this:
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OR

File MD5 is c4b0458c04abdaa773348c28€8212b45

-

File Name containg a.exe

Tile MName contains b.exe

File Name ccontains c.exe

AND
. O.R

Tile
File

" OR

File
File

Compile
Compile

Size ig 9216
Size i3 9245

15. Right-click 1st “AND” -> Add Logic -> Select “*AND”

Time is 2011-10-13T04:18:532
Time ias 2011-10-19T702:39:122

16. Right-click 2nd “AND” -> Add Item -> File Item -> File Full Path -> Type “\temp\”

i 'w~File Size iz 9245

b on Filelter |
| l“File Compile Time is 20] FormHistoryltem >
x “ File Compile Time is 201 Hiveltem ’
L Add Item » Hookitem 4
h Add Logic » Moduleltem 4
Change Logic > Network '

File Filename Modified

File Full Path

File Import Function
File Import Name
File INode

File MD35

File Modified Time

17. Right-click 2nd “AND” -> Add Item -> File Item -> File Strings -> Type “httppump”

i t.File Size is 924535

E} o Fileltem 4 '
| ~File Compile Time is 20] FormHistoryltem ’
. File Compile Time is 201 Hiveltem »
& AN
: Add ltem » Hookitem ’
L Add Logic » Moduleltem »
Change Logic > Network ’

File Shalsum
File Sha256sum
File Size

File Stream Shaisum

File Stream Sha236su
File Strings ‘
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OoR

File MD5S is c4b04538c04abdaa773348c26€8212b45
File Name contains z.exe
File Name contains b.exe
File Name contains c.exe
A
OR
File Size is 921
File Size is 8245
OR
File Cecmpile Time is 2011-10-13T704:19:532
File Compile Time is 2011-10-18T02:38:122
AND
File Full Path contains \temp\
PPUED

18. Right-click 2nd “AND” -> Add Item -> Registryltem -> Registry Key Path -> Type
“\CurrentControlSet\Services\Netman\domain”

Detected Anomaly
Registry Hive

Registry Key Modified Date

Registry Key Path

_3“ AND vkl
File Full Path contains \temp\ Hookltem
':‘i_le S_c:in?s ccm:\aj.ns k?i:ppfmp . Moduleltem
egis X h contains \CuzzentCoptrd Network
Add ltem | chwor
| AddLogic » Portitem
[ Add Another Prefetchltem
I Processitem
Change Term b e
| | Registryltem
I Change Condition  » [~ —— —— — — -
] Britebntrdtam

Reaictne M Sishieve
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19. Congrats!! You have completed and added your first 10C. 1t should look like this in the end:

OR
File MD3 13 c4b0458c04abdaa773348c2688212b45
File Name contains a.exe
File Name contains b.exe
File Name ccntains c.exe
AND
oR
File Size isg 9216
File Size is 824S
oR
File Ceompile Time is 2011-10-13T04:19:532
File Compile Time is 2011-10-18T702:39:122
AND
File Full Path contains \temp\
File Strings contains httppump
Registry Key Path ceontains \CurrentContrclSet\Services\Netman\domain

Exercise Takeaways

Building a good 10C is sometimes tedious, but an analyst that is armed with a decent |OC list is extremely
powerful. There are many indicator languages out there including STIX, YARA, and OpenlOC. Threat indicators
and management is extremely important during incident response.

In upcoming sections, we will talk about tools like Redline and Volatility that have built-in OpenlOC support.

Using capabilities such as Live Analysis with Redline, it is feasible to scan a single target with both host and
process based indicators.

Understanding how an indicator is built and how it can be used to look for malware variants is important for
incident response and hunting. The best information your malware analysis team can provide is a strong

threat indicator for the host and the network scanning teams. Learning the basics of how to build one is useful
and is as much of an art as a science.

As you work through an investigation, discovering artifacts and creating indicators is a key skill since threat
indicator scanning is one of the best ways to scope large enterprises.
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WIN10 DOT NET INSTALLATION ISSUES? — TRY THIS

Press Windows key and R at the same time

Type appwiz.cpl in the Run command box and press Enter

In the Programs and Features window, click on the link Turn Windows features on or off
Check if the .NET Framework 3.5 (includes .NET 2.0 and 3.0) option is available in it

If yes, then enable it and then click on OK

o v e wWwNRE

Follow the on-screen instructions, complete the installation and restart the computer, if the process requests that from
you

Besides installing .NET Framework 3.5 through the Control Panel, you can also install it on-demand. If a certain app requires the .NET
Framework 3.5, but this feature isn’t enabled on your computer, the installation wizard will display the prompt for installing .NET
Framework 3.5 on demand. To install .NET Framework 3.5, in this prompt choose the option “Install this feature,” and .NET
Framework 3.5 will be automatically installed on your computer.

But some users have reported that they get a certain error message after they try to install .NET Framework 3.5 through the Control
Panel or on-demand. To avoid this error, try to install .NET Framework 3.5 with the Command Prompt. To do that, follow these
steps:

Press Windows key and R at the same time

Type cmd in the Run dialog box and press Enter

And enter the following line in the Command Prompt: DISM /Online /Enable-Feature /FeatureName:NetFx3 /All
/LimitAccess /Source:installationMediaDrive:\sources\sxs
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Exercise 1.4 - Autostart Persistence Analysis

Objectives

1. Filter and examine output from autorunsc.exe.

2. Identify suspicious processes using the “What Is Normal Poster?” and an understanding of core
Windows operating system processes and services

Exercise — Are There Suspicious Persistence Mechanisms on 10.3.58.5?

The autorunsc. exe tool was executed during live response on system 10.3.58.5 (example only — you do
not need to run this as the output file has already been provided to you).

C:\> autorunsc.exe -accepteula -a * -s -h -c > autoruns-win7-32-
nromanoff.csv

Your mission in this exercise is to review the output file and find evil.

STEP-BY-STEP — Autoruns Filtering

1. Using Microsoft Excel, open the autoruns-win7-32-nromanoff . csv file found on your USB
under win7-32-nromanof£f-10.3.58.5\win7-32-nromanoff-incident-response\.
Simply double-clicking autoruns-win7-32-nromanoff . csv usually works.

2. Select View -> Freeze Panes -> Freeze Top Row.

VIEW ACROBAT

] E “&] Edsplit  CDView Side by Side Efj
-  {iHide n- ronous Scrolling )
New Arrange Freeze ) . Switch
Window All  Panes~ [CJunhide t ¥indow Position  \Windows ~

. Freeze Panes L__
- . . .
# Keep rows and columns visible while the rest of
the worksheet scrolls (based on current selection).
Freeze Top Row

' Keep the top row visible while scrolling through 2
Stt MD5S SHA the rest of the worksheet.

SRS

A\

Freeze First Column 2371

pck 23043¢91a 2d3
Z Keep the first column visible while scrolling :
43c757488 3d7| through the rest of the worksheet. 81&

MF 39a3daa7f 4325 scou7 U7LI07 LHBUI FaBEUUL LUs 2UUEU LD 213 2Lunuui e d 88
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3. Hide Columns “SHA-1” and “SHA-256."

BI=OO--A-F-%9%9%8w

J 74
SHA-1 sHa2 o6 Cut
h9{2d339527dc985beSac318a61 FB Copy
h513071239f992fe678a1:54ecct T, Paste Options:
71|43295c3a78d9fef4eq 67c95¢ =, =
00|ef5728c819f466bfesEaSe1dr 2
3327bd21614019390492 49900;  "2ste pecial-
e0{8daf0f7cfa79df9fe76:462c9: Insert
52| 164e9ce62baca39ad7 3c7ceh
4193e0bcac8b09e6e211 3430
545e29256f3e47541a02 65d23!
,5450000222b0f37a85d6 8ag11( (=) Format Cells..
797592be5153e92d5f398 08259t Column Width...

124 Hide

o7 Unhide
6 -

Delete

Clear Contents

4, Select Home Ribbon.

}(j H )~ e
Home Insert Page Lay:
B ‘)fc”t Calibri
=3 Copy ~
L U~

3 Format Painter
Clippoard

5. Select All Cells or "CTRL-A."

6. In Home Ribbon -> Sort and Filter -> Filter

7. Filter out all signed and trusted (verified) startup locations from view.

3
12

Select the “Publisher” column and filter for only those publishers that you are not sure about.
Although this can lead to false negatives, it is a reasonable first step towards data reduction, making

abnormalities easier to identify.

Note: There are some examples of well-known trusted publishers having their code signing
certificates stolen. However, if you happen to discover a new one, especially a stolen certificate from
Microsoft, Apple, Google, or McAfee, this would be nationwide news, and you should prepare for
your 10 minutes of fame as you will be heavily interviewed on how you discovered it. In a nutshell,
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initially eliminate well-known trusted publishers from your examination. Although not impossible, it
is extremely rare that malware will be using a trusted certificate from Microsoft to sign its code.

a. Select the drop-down filter next to “Publisher” and unselect “(Select All)”.

E F
fion v Publisher v
8l SortatoZz
Zl SotZtoA
Sort by Color 4
Text Filters »
rch £
TR (Select All) -
7] (Not verified} Apple Inc.
-.[/] (Not verified) Igor Paviov
--{7} (Not verified) Microsoft Corporatic
-.[] (Not verified) VMware, Inc.
[/ (Verified) Adobe Systems, Incorpot
[} (Verified) Agile Risk Management
..[] (Verified) Apple Inc.
--{] (Verified) Google In¢ v
(e s
OK Cancel
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b. Select all publishers that are “Not Verified.”

© 2016 Rob Lee

2!
&l

SortAtoZ

SortZto A

Sort by Color
ot

tr
Text Filters

Search

- (M (Select All)
-] (Not verified) VMware, Inc.
-] (verified) Adobe Systems, Incorporated
-] (Verified) Agile Risk Management LLC
- {1 (Verified) McAfee, Inc.
- "] (verified) Microsoft Corporation
-] (Verified) Microsoft Windows

~[_] (Verified) Sysinternals
-[_] (Verified) ThinPrint GmbH
-] (Verified) VMware, Inc.
-] (Blanks})

~{_| (Verified) Microsoft Windows Hardware Compatibility Publisher

Cancel
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c. Also select any publishers not immediately recognized as a core software publisher (for
example, something you might need to “Google search” to verify they are a real company).

2l SortAtoZ
2l SotZtoA
Sort by Color »
£
Text Filters
Search
-~ W] (Select All)

- [¥] (Not verified) VMware, Inc.

7] (verified) Adobe Systems, Incorporated
L[] (verified) McAfee, Inc.
~ (Verified) Microsoft Corporation
~ (Verified) Microsoft Windows
("1 (verified) Microsoft Windows Hardware Compatibility Publisher
] (Verified) Sysinternals
(Verified) ThinPrint GmbH b
~[] (verified) VMware, Inc.
L[] (Blanks)
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d. Finally, before you click “OK,” also select “blanks.” Blanks include those entries with no
publisher information and no digital signature.

ter

B (Select All)
v (Not verified} VMware, Inc.
{Verified) Adobe Systems, Incorporated
v (Verified) Agile Risk Management LLC
(Verified) McAfee, Inc.
(Verified) Microsoft Corporation
(Verified) Microsoft Windows
(Verified) Microsoft Windows Hardware Compatibility Publisher
(Verified) Sysinternals
v Verified) ThinPrint GmbH

| (Verified) VMyare, Inc.
v (Blanks) b

8. You are now ready to start your analysis!
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Exercise — Autoruns Output Analysis

For this exercise:
1. Briefly review your filtered autorunsc.exe output (or use the excerpt on the next page).

2. Record the “Image Path” for any suspicious entries worth investigating further. You do not need to use
every line provided. (Hint: “File not found” means there is an entry pointing to a file that is no longer
present in the file system. This could be caused by an uninstalled application that did not clean up its
autostart entry. They are worth reviewing, but not inherently suspicious.)

3. Compare image paths identified in the last question against any system processes that are present on
the “What Is Normal” Poster {available in digital form on your SIFT desktop and on your class USB).
What is the most likely candidate for a suspicious process?

4. List what is wrong or odd about the selected suspicious process. (Advanced: There are at least five
things wrong with the Autoruns entry).

5. What resources could you use to check your other suspicious processes for validity?
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Entry Location image Path Launch String
HKLM\System\CurrentControlSet\Services FResponse Service  Services c:\windows\sy 2\l-resp texe f-response-ent.exe
HKLM\System\CurrentControlSet\Services mfeavfkOl Drivers File not found: C:\Wi \System32\Drivers\mfeavik01.sys mfeaviko1
HKLM\System\CurrentControlSet\Services Synth3dVsc Drivers file not found: System32\drivers\synth3dvsc.sys System32\drivers\synth3dvscsys
HKLM\System\CurrentControlSet\Services tsusbhub Drivers tile not found: sy \drivers\ sys v P\drivers\tsusbhub.sys
HKLM\System\CurrentControlSet\Services VGPU Drivers file not found: System32\drivers\rdvgkmd.sys System32\drivers\rdvgkmd.sys
HKLM\SYSTEM\CurrentControiSet\Control\Print\Monitc ThinPrint Print Port A Print Monitors c\windows\sy 2\tp dh TPVMMon.dil
HKLM\System\CurrentControlSet\Services\WinSock2\P: VMCi sockets DGRAN Network Providers c:\program fites\ \ tools\vsock sdk\bim\win32\vsocklib.dll  C:\Program Files\VMware\VMware Tools\VSock SDK\bin\win32\vsocklib.di
HKLM\System\CurrentControlSet\Services\WinSock2\P: VMCI sockets STREAR Network Providers c:\program files\ \ \vsock sdk\bin\win32\vsocklibdlf C:\Program Files\VMware\VMware Tools\VSock SDK\bin\win32\vsocklib.d!

! ,\ HXLM\SOFTWARE\Microsoft\Windows\CurrentVersion‘svchost Logon n}i._iosa/c\bn:.qu::\llE:ﬁ__our...xm c:\windows\system32\dithost\swchost.exe
Task Scheduler \Microsoft\Windows' Tasks File not found: %ProgramwG432%\Windows Media Player\wmpnscfg.exe “%ProgramFiles%\Windows Media Player\wmpnscfg.exc”

Exercise 1.4 - 8
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/

STEP-BY-STEP — Autoruns Output Analysis /

1. Briefly review your filtered autorunsc.exe output (or use the excerpt on the previous page).

2. Record the “Image Path” for any suspicious entries worth investigating further. You do not need to use
every line provided. (Hint: “File not found” means there is an entry pointing to a file that is no longer
present in the file system. This could be caused by an uninstalled application that did not clean up its
autostart entry. They are worth reviewing, but not inherently suspicious.)

c:\windows\system32\f-response-ent.exe (has a verified digital signature)

c:\windows\system32\tpvmmon.dll (has a verified digital signature)

c:\program files\vimmware\vmware tools\vsock sdk\bin\win32\vsocklib.dll

c:\windows\system32\dllhost\svchost.exe

While some of the “File not found” entries could look suspicious, they are not currently present and
thus cannot be active persistence mechanisms. Also note that since they were not present, Autoruns
could not provide their description, publisher, and digital signature verification. in a real
investigation, it might be worth checking against a baseline for those file names or doing a cursory
Google search, but we probably would not invest a lot of time.

3. Compare image paths identified in the last question against any system processes that are present on
the “What Is Normal” Poster {available in digital form on your SIFT desktop and on your class USB).
What is the most likely candidate for a suspicious process?

c:\windows\system32\dllhost\svchost.exe
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svchost.exe

Image Path: %SystemRoot%\System32\svchost.exe
Parent Process: services.exe

| Number of Instances: Five or more

User Account: Varies depending on svchost instance; although, it typically will be Local System,
Network Service, or Local Service accounts. Instances running under any other account should be
investigated.

Start Time: Typically within seconds of boot time. However, services can be started after boot, which
might result in new instances of svchost.exe well after boot time.

Description: The generic host process for Windows Services. It is used for running service DLLs.
Windows will run multiple instances of svchost.exe, each using a unique “-k” parameter for grouping
similar services. Typical “-k” parameters include BTsvcs, DcomLaunch, RPCSS,
LocalServiceNetworkRestricted, netsvcs, LocalService, NetworkService, LocalServiceNoNetwork,
secsvcs, and LocalServiceAndNolmpersonation. Malware authors often take advantage of the
ubiquitous nature of svchost.exe and use it either directly or indirectly to hide their malware. They
use it directly by installing the malware as a service in a legitimate instance of svchost.exe.

Alternatively, they use it indirectly by trying to blend in with legitimate instances of svchost.exe,

either by slightly misspelling the name (for example, scvhost.exe) or spelling it correctly but placing it

in a directory other than System32. Keep in mind that a legitimate svchost.exe should always run

from %SystemRoot%\System32, should have services.exe as its parent, and should host at least one

service. Also, on default installations of Windows 7, all service executables and all service DLLs are
signed bv Microsoft.

4. List what is wrong or odd about the selected suspicious process. (Advanced: There are at least five
things wrong with the Autoruns entry).

c:\windows\system32\dllhost\svchost.exe is the suspicious process.

a. Image Path is C:\Windows\System32\dllhost. It should be C:\Windows\System32.

b. Entry Location shows svchost.exe being referenced by
HKLM\SOFTWARE\Microsoft\Windows\CurrentVersion\Run, but the poster identifies the
owning parent of svchost to be Services.exe. (Given this, we would expect the Entry Location
to be HKLM\System\CurrentControlSet\Services.)

c. Because svchost.exe is present in a "Run" registry key, its start time will be when a user logs
on to the system, not at boot as identified on the poster.

d. The Launch String (command line) should include a “-k” parameter as mentioned in the
poster description field for svchost.exe.
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e. The code is not signed by Microsoft. (Remember at the beginning of this exercise we filtered
the data, including removing any signed and verified programs from Microsoft.) Svchost.exe
is a core windows process and should be signed and verified by Microsoft similar to the actual
file that exists in the C: \Windows\System32 folder.

Finding any one of these would be a good enough reason to look deeper at this suspicious process. If
you identified all of them from the output provided, you are a ninja!

5. What resources could you use to check your other suspicious processes for validity?

After checking for digital signatures, the next logical step in checking validity of suspicious entries
would be to compare the file hash provided by Autoruns against a known good hash database. We’'ll
discuss hash databases later in the course. Researching the vendor and product listed in the
“Publisher” and “Description” fields would be another way to gather more information. Finally,
comparing this output with baselined output from a similar system (hopefully known to not be
compromised) could help to identify abnormalities.

Exercise Takeaways

In an intrusion case, spotting the difference between abnormal and normal is often the difference between
success and failure. Your mission is to quickly identify suspicious artifacts to verify potential intrusions.

Unless you already know and understand Windows OS processes, it is fairly difficult to identify suspicious
processes solely via tool output. Although having a big collection of output from various incident response
tools is nice, it is not useful if you cannot quickly and easily identify anomalies. Knowing what is normal on a
Windows host helps cut through the noise to quickly locate potential malware.

As a result of your examination of the autorunsc.exe output from the 10.3.58. 5, we have identified a
suspicious process called svchost in an incorrect directory c¢: \windows\system32\dllhost that
starts automatically when a user logs into the system.

Looking up processes on the “What is Normal” poster was intended to help facilitate memorization of a key
Windows process, svchost. exe, and the properties that it should exhibit on a Windows operating system.
You should also take it as homework to familiarize yourself with the other processes listed on the “What is
Normal” poster.

Shortly we will begin memory analysis and attempt to identify if svchost is running and if it has any
additional suspicious indicators.

© 2016 Rob Lee Exercise 1.4 — 11




This page intentionally left blank.



Optional Exercise - Exercise 1.5A -

Conference/Onsite Version

Description

This version of the lab is intended to demonstrate the capabilities of remote forensic and incident response
analysis by connecting to a system that the instructor has set up. This is typically in classes where we are live
and have limited access to additional systems for this exercise.

When you return to your own lab, work, home network, or if you are attending the class via On-Demand,
vLive, or Simulcast remotely, please accomplish Exercise 4B.

In Exercise 4B, you will not only configure the Enterprise License server, but you will also create your own
agent, deploy it in your network, and connect to another host in your environment. Not only is it a bit more
complex, but it also usually takes about twice as long to complete. In a classroom environment, we will
demonstrate remote forensics by having the students connect to a preexisting deployed agent scenario to
demonstrate the features of remote incident response.

If attending in a live conference or onsite course, the instructor will set up a demonstration system (or two) to
have you connect to. Please obtain that IP address from the instructor.

If you are an On-Demand, vlive, or Simulcast student, please accomplish Exercise 4B.

Exercise Preparation

Receive any IP addresses from your instructor that you can connect to.

IP ADDRESS:

Objectives

e Connect/disconnect to remote system hard drives and memory using the SIFT Workstation.

Exercise — Install and Configure F-Response Enterprise

1. Start your SIFT VMware Workstation in VMware.
2. Loginthe SIFT VMware machine.

» LOGIN = sansforensics
» PASSWORD = forensics
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3. IMPORTANT! Open a terminal inside the SIFT Workstation and make sure you are a root user by
running the command sudo su -.

$ sudo su -

Exercise — Use the SIFT Workstation to Connect to Remote System(s) You Have Deployed the Agent to and Started the
Service

1. Switch to your SIFT Workstation.
2. Login to see the available nodes. (Note in this example that we are using the server IP, which on my
system is 192.168.112.1, but on your system, this should match the IP address that your instructor

provides you.)

IP_ADDRESS = Instructor-provided IP address

l$ sudo su -

# f-response-accel-lin -n sansforensics -p forensicsl234 -s IP ADDRESS

root@siftworkstation:/# f-response-accel-lin -n sansforensics -p forensics1234 -s 192.168.112.1
F-Response Acclerator - Linux Version 5.0.3

F-Response Acclerator for Linux requires Open-iSCSI.

Checking for Open-iSCSI utils now..

Dpen-1SCSI (iscsiadm) found.

Connecting to F-Response Target 192.168.112.1:3260...

Discovery Results.
F-Response Target = iqn.2008-02.com.f-response.jotumheim:disk-0
F-Response Target = iqn.2008-02.com.f-response. jotumheim:vol-c
F-Response Target = iqn.2008-02.com.f-response. jotumheim:pmem
Populating Open-iSCSI with node details..

Node information complete, adding authentication details.

unu

3. Loginto Remote Hard Drive Target. It is usually Disk-0. Note in the preceding example, my system name
was jotumheim. The exact name of the system you are logging in to will change for each system you
are logging in to. Please note that it is a lowercase “L” in the £-response-accel-1in command.
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oot@siftworkstation:/# f-response-accel-lin -1 ign.2008-02.com.f-response.jotumheim:disk-0

-Response Acclerator - Linux Version 5.0.3

-Response Acclerator for Linux requires Open-iSCSI.

ogging in to [iface: default, target: ign.2008-02.com.f-response.jotumheim:disk-0, portal: 192.168.112.1,3260]

ogin to [iface: default, target: iqn.2008-62.com.f-response.jotumheim:disk-0, portal: 192.168.112.1,3260]: successful
ON:1qn.2008-02.com. f-response. jotumheim:disk-0 attached as /dev/sdc
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4. Run fdisk -1 and examine the output locating a new drive that is attached at /dev/sdc.

# fdisk -1

Disk /dev/sdg: 214.7 GB, 214748364800 bytes
255 heads, 63 sectors/track, 26108 cylinders, total 419430400 sectors
Units = sectofs of 1 * 512 = 512 bytes
Sector size (Upgical/physical): 512 bytes / 512 bytes
I/0 size (minifkum/optimal): 512 bytes / 512 bytes
Disk identifiers 0x47856f08
Device Boot
/dev/sdc1 *

Start End Blocks Id System
2048 419428351 209713152 7 HPFS/NTFS/exFAT

5. Mount the larger partitio.n via the SIFT Workstation using the mount command. (Note: /dev/sdc2 is
what it is on the example;'a{our actual results will vary depending on your system.) You can determine the

largest partition by examintg the partition with the largest number of blocks. Also, usually on Win7 and
later systems the 2nd partitic'y.n is the C:\ of the system.

# imageMounter.py /dev/sdc /mnt/windows_mount2

root@siftworkstation:/home/sansforensics# imageMounter.py /dev/sdc /mnt/windows |
mount2/
[+] Creating Temp Mount Point at /mnt/windows_mount2/0
[+] Attempting to Mount Partition 0 at /mnt/windows_mount2/0
[-] Mounted /dev/sdc at /mnt/windows_mount2/0
[-] To unmount run 'sudo umount /mnt/windows_mount2/0'

6. Change directories to the /mnt/windows_mount2 directory and examine files. You should now be
able to see the files from the remote system with the F-Response Agent installed. Below is a generic
example.

# cd /mnt/windows_mount2/0

# 1s
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root@siftworkstation:/home/sansforensics# cd /mnt/windows_mount2/6/
root@siftworkstation:/mnt/windows_mount2/0# 1s

- SSecure

ESEER Yoliine informatiod
cases -
I L o

7. Change directories to the Windows/System32/config directory and extract the registry contents
of the SAM and SYSTEM hives. Please note that due to “lower/upper case conversions” your exact
directory path might vary on your own system. You might need to use “tab complete” to help you
complete the directory path.

cd /mnt/windows_mount2/0
cd Windows/System32/config

rip.pl -r SAM -f sam > /cases/sam.txt

H H= H= I

less /cases/sam.txt

root@siftworkstation:/mnt/windows_mount2/1# cd Windows/System32/config/
root@siftworkstation:/mnt/windows_mount2/1/Windows/System32/config# rip.pl -r SAM -f sam > /cases
/sam.txt

Parsed Plugins file.

Launching samparse v.20120722

samparse complete.

root@siftworkstation:/mnt/windows_mount2/1/Windows/System32/config# less sam.txt

# rip.pl -r SYSTEM -f system > /cases/system.txt

# less /cases/system.txt
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Exercise — Attach remote memory and perform some basic memory examination commands

1. Login to the appropriate target, usually PMEM. Please note that it is a lowercase “L” in the £-

-------

root@siftworkstation: /# f-response-accel-lin -1 iqn.2008-02.com.f-response. jotumheim:pmem

F-Response Acclerator - Linux Version 5.0.3

F-Response Acclerator for Linux requires Open-iSCSI.

| ogging in to [iface: default, target: iqn.2008-02.com.f-response.jotumheim:pmem, portal: 192.168.112.1,32606]

Login to [iface: default, target: ign.2008-82.com.f-response.jotumheim:pmem, portal: 192.168.112.1,3260]: successful
TON:ign.2008-02.com.f-response. jotumheim:pmem attached as /dev/sdd

2. Run fdisk -l and examine output locating the memory image.i
a. It should not show a valid partition table at /dev/sdd.

# fdisk -1

Disk /dev/sdd: 9636 MB, 9636413440 bytes

64 heads, 32 sectors/track, 1148 cylinders, total 2352640 sectors
Units = sectors of 1 * 4096 = 4096 bytes

Sector size (logical/physical): 4096 bytes / 4096 bytes

I/0 size (minimum/optimal): 4096 bytes / 4096 bytes

Disk identifier: 0x00000000

Disk /dev/sdd doesn't contain a valid partition table

In the next section, you will learn how to use Volatility and Redline during memory analysis.

Some examples of commands we could run if connected over to memory on a remote system

View running processes # vol.py —-f /dev/sdd pslist
View open TCP network connections # vol.py -f /dev/sdd connections
Recover Internet Explorer history from RAM # vol.py —-f /dev/sdd iehistory >

/cases/iehistory. txt
# less /cases/iehistory.txt
View registry hives present in memory # vol.py -f /dev/sdd hivelist

Parse Userassist key from RAM # vol.py ~f /dev/sdd userassist >
/cases/userassist. txt

# less /cases/userassist.txt
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Exercise — Detach Remote F-response Targets

1. Detach the remote target system memory and hard drives.

# cd /

# umount /mnt/windows mount2/0
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Exercise Takeaways

Being able to connect to 100s of systems in your environment to perform incident response is critical. Using a
deployable agent via group policy will allow you to connect to almost any IP address in your environment.

The next step is analysis and then making it automated, using a script to connect and pull specific data from
100s of systems in your enterprise.

The days of pulling a hard drive each time you want to analyze a system are over. The time to be able to
perform remote analysis is here, and using tools such as F-Response, Mandiant MIR, Encase Enterprise, and
many others gives you the ability to scale from a single system to thousands.
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Optional Exercise - Exercise 1.5B - Enterprise

Forensics (OnDemand/vLive/Simulcast) Version

Description

This version of the lab is intended to demonstrate the capabilities of remote forensic and incident response
analysis by connecting to a system that the instructor and faculty have set up. This typically would be in
classes where we are live and have limited access to additional systems for the setup. This exercise will not

only show you how to connect to remote systems, but also how to set up, configure, and deploy F-Response
Agents on your own networks.

In this exercise you will not only configure the F-Response-Enterprise License server, you will also create your
own agent, deploy it in your network, and connect to another host in your environment.

Please note: This follow-on exercise is meant to be completed on your own networks and not in live classroom
environments such as SANS conferences or onsites. To demonstrate F-Response, the instructor will set up a
system for students to connect to. If attending a live conference or onsite course, the instructor will set up a

demonstration system (or two) to have you connect to; please follow Exercise 4A. Obtain that IP address from
the instructor.

If you are an On-Demand, vLive, or Simulcast student, continue with Exercise 4B.

Note: If you are having trouble with the F-Response Enterprise Lab Setup, there is a troubleshooting guide at
the end of this exercise.

Objectives
1. Install and configure an enterprise incident response and forensics capability.
2. Create a deployable agent.
3. Deploy agents on to target systems in your environment.
4. Connect/disconnect to remote system hard drives and memory using the SIFT Workstation.

Exercise — Install and configure F-Response Enterprise

1. Start your SIFT VMware Workstation in VMware.
2. Login the SIFT VMware machine.

» LOGIN = sansforensics
» PASSWORD = forensics

3. Open aterminal inside the SIFT Workstation and make sure you are a root user by running the
command sudo su -.
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$ sudo su -

4. SIFT WORKSTATION: Check the IP address of SIFT Workstation using “ifconfig.”

$ ifconfig

Note you are looking for output similar to the following where the IP address of the example system is
192.168.112.138.

sansforensics@siftworkstation:~$ ifconfig
ethe Link encap:Ethernet HWaddr 66:0c:29:61:54:df
net addr:192.168.112.138 Bcast:192.168.112.255 Mask:255.255.255.0
inet6 addr: fe806::20c:29ff:fe61:54df/64 Scope:lLink
UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1
RX packets:838 errors:0 dropped:® overruns:® frame:®
TX packets:2503 errors:© dropped:0 overruns:0 carrier:0
collisions:® txqueuelen:1600
RX bytes:562499 (562.4 KB) TX bytes:244357 (244.3 KB)

Read the “inet addr” of your output and write down the IP Address of your SIFT Workstation.

SIFT IP ADDRESS =

5. Locate and insert your F-Response Enterprise Dongle into your Windows system.

6. Windows system: Turn off your windows system firewall or open up ports on your enterprise
network to allow for the following ports to communicate over TCP (Control Panel -> System and
Security -> Windows Firewall -> Turn Firewall On or Off) .

1. 3260: This is the main port F-Response uses to communicate with the target machine’s resources
(iSCSI TCP).

2. 5681: This port is used to communicate with the F-Response Licensing Manager. (TCP is used for
most editions of F-Response; UDP is used for F-Response Tactical Edition.)

7. Insert your COURSE USB with DFIR on the side into your Windows system.
e Navigate to \SIFT-Lab-Install\F-Response-Enterprise.

8. Install “F-Response Enterprise” software (F-ResponseEnterprise.exe)onyour
Windows system. All steps require you to simply select “Next” and finally “Install” and
“Finish.”
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Welcome to the F-Response |
Enterprise Edition Setup Wizard

Thank you for purchasing F-Response Enterprise Edition.

Please remember, the most current version of F-Response

Enterprise Edition is always available online at

|
www.f-response.com. ‘
)

This setup application will install F-Response Enterprise Edition
on your computer.

It is recommended that you close all other applications before
continuing.

Click Next to continue, or Cancel to exit Setup.

s— Kleﬂ > \_ Cancel

553 Setup - F-Response Enterprise Edition  — =

License Agreement 7
Please read the following important information before continuing

Please read the following License Agreement. You must accept the terms of this
agreement before continuing with the instaliation.

IAGILE RISK MANAGEMENT LLC MASTER SOFTWARE LICENSE AGREEMENT A
TERMS AND CONDITIONS

1 Scope of Agreement; Definitions. This Agreement covers the license and
permitted use of the Agile Risk Management LLC (“Agile”) F-Response Software.
Unless otherwise defined in this section, the capitalized terms used in this
Agreement shall be defined in the context in which they are used. The following
terms shall have the following meanings:

1.1 “Agile Software" or "Software" means any and all versions of Agile's F-
Response software. !
12 “Customer” means the person or entity identified on the invoice and only v

»@) | accept the agreement

| (O I do not accept the agreement

< Back ext > Cancel
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i Setup - F-Response Enterprise Edition = E’-

Select Destination Location '
Where should F-Response Enterprise Edition be installed?

Setup will install F-Response Enterpnse Edition into the following folder.

To continue, click Next. If you would like to select a different folder, click Browse

—
1o

Browse

Atleast 18.8 MB of free disk space is required.

< Back Next > Cancel

15 Setup - F-Response Enterprise Edition — &

Select Start Menu Folder
Where should Setup place the program's shortcuts?

| Setup will create the program’s shortcuts in the following Start Menu folder.
To continue, click Next. if you would like to select a different foider, click Browse.

Browse...

< Back Next > i Cancel J
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Setup - F-Response Enterprise Edition  — D‘

Ready to Install
Setup is now ready to begin installing F-Response Enterpnise Edition on your

computer.

Click Install to continue with the installation, or click Back if you want to review or change

any settings.

Destination location:
C\Program Files\F-Response

Start Menu folder:
F-Response Enterpnse Edition

\a

< Back Install

Cancel

Setup - F-Response Enterprise Edition

your computer.

Click Finish to exit Setup.

Finish

Completing the F-Response
Enterprise Edition Setup Wizard

|
Setup has finished installing F-Response Enterprise Edition on ‘

Don't forget to insert your F-Response License dongle before
installing and starting the F-Response License Manager Server.

In addition, F-Response requires the Microsoft iSCSI Initiator
(Windows XP), if you have not already installed the Microsoft
iSCSI [nitiator and are using Windows XP please use the link
below. Windows Vista, 2008, and 7 users already have iSCSI
installed and will see no link. U.S. Pat. No. 7,899,822 8,171,108
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Exercise — Set Up the F-Response Enterprise License Manager

1. Insert F-Response Enterprise Dongle into a Windows operating system. The F-Response Enterprise
software you just installed allows you to create remote agents. It will also serve as your license manager
for remote workstations connecting to other system targets in your environment.

2. Launch LICENSE MANAGER MONITOR.

[} F-Response Enterprise Edition
f3 F-Response Accelerator
2. F-Response Cloud Connector
ﬁ F-Response Database Object Conne
ffv;! F-Response Email Connector
f3 F-Response Enterprise Management
i ' F-Response License Manager Monitort

_ B2 Uninstall F-Response Enterprise Editi
i f3 Update F-Response Dongle v

3. Install F-Response LM Service and check “Set to Auto Start.”

/3 F-Response License Manager Mo... — = “

License Manager Configuration
IP Address: | 192.168.1.43 ~|

License Manager Control

G

[V Set to Auto Start?

Start F-Response LM Service

st |
= l Stop F-Response LM Service
_uniostat |

1 Uninstall F-Response LM Service

OK |
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From the “IP Address:” drop-down select the IP address that matches the same subnet of your SIFT
Workstation IP address documented in step 4 during your preceding Exercise Preparation. NOTE: In the
example listed here, our SIFT IP address was “192.168.112.138"; thus the IP address of the License
Manager will need to be on the same subnet “192.168.112.1."

/@ F-Response License Manager Mo... — O S

License Manager Configuration
IP Address: [EFRTEEEEN
TCP Port: 192 168. L 43 -
(192,168,112 10 AN
192.168.29.1

License Manager Control

I Insta’ F-Response LM Service

qfi— Start ‘ Start F-Response LM Service
- l Stop F-Response LM Service

Uninstall F-Response LM Service
oK I

5. Startthe “F-Response LM Service” and select “OK."”

/3 F-Response License Manager Mo... = =5
License Manager Configuration
IP Address: l _J
TCP Port:l
License Manager Control

l Instal FResponse LM Service

i; g:’ . | Start F-Response LM Service
e Stop I Stop F-Response LM Service

: Uninstall F-Response LM Service
OK l
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Exercise — Create a Deployable Remote Forensic Agent

1. Llaunchthe F-Response Enterprise Management Console.

F-Fiesgo_r;s} Eﬁ:{ce_réyi;e Eci_igion___ 0
/3 F-Response Accelerator

¥ F-Response Cloud Connector

ﬁ F-Response Database Object Conne
& F-Response Email Connector

_,'_F-Response Enterprise Managerﬁent Console

/3 F-Response License Manager Monitc
[@ Uninstall F-Response Enterprise Editi:
f3 Update F-Response Dongle

]

Helg

f_-" F-Response® Enterprise Management Console

File Scan Deployment Connect Active Clients Help

2. SelectFile -> Configure Options.

f‘ F-Response® Enterprise Management Console

| Fle Scan Deployment Connect Active Clients Help

Configure Credentials...

Configure Options... #‘

Clear Messages
Ext

© 2016 Rob Lee
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Deployment Options Configure

F-Response Configuration
License Manager Configuration Host Configuration
Encryption [ ]
IPAddr 192 . 168 . 112 . 1 Physical Memory [¥]
TCP Port 5681 Flexdisk™ [] Port 3261
TCPPort 3260

Username  sansforensics

Passwofd 2680000080000

F-Response Windows Service Install Configuration
Service Name  F-Response Agent Service
Service Description | F-Response Enterprise Agent Serw:el
Executable = C:\Program Files\F-Response\F-Respol. | Browse

Unix Platform Spedfic Deployment Options

Platform v Reset Current Reset Al
Pre and Post Exec{Optonal)

Pre Start

Post Stop

Additional Targets

Export... Export MSI... Cancel oK

You will need to configure the following:

e License Manager IP -> DO NOT CHANGE
e License Manager Port -> 5681 - DO NOT CHANGE
e Host Configuration-> Physical Memory-> CHECKED

e Username -> sansforensics

e Password -> forensicsl234

e Service Name -> F-Response Agent Service

e Service Desc-> F-Response Enterprise Agent Service

e Executable -> C:\program files\f-response\f-response enterprise

edition\f-response-ent.exe

Press Ok to save changes.
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3. “SelectFile -> Configure Options” again.

F F-Response® Enterprise Management Console

| Fle Scan Deployment Connect Active Clients Help
Configure Credentials...
Clear Messages
Exit

e = !

4. Click the button at the bottom of the window to Export the deployable F-ResponseAgent.MSI. When
created, this .msi file can be distributed to thousands of systems in your environment.

REE )

Additional Targets ]

Export... | ExportmsL... |

]

Browse for Folder

Export MSL...

€l Network

{3 Libraries

A mshannon

B % Computer
3 Floppy Disk Drive (A:)
ﬁ, Local Disk (C?)
£ ovp Drive (0:)

| OK I Cancel
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5. Deploy Agent(s) to systems you would like to examine remotely. We recommend another system on
your network or lab. You can also use your own host, but it doesn’t show the true capabilities of the
enterprise incident response capability. Launch the “£response .msi” program on your local system

by double-clicking it.

Typically, we would deploy the agent to other systems in our environment via Group Policy or the F-Response

Enterprise Management Console.

For this example, we are going to install the F-Response Agent Service on the same system we are using as the

license server. However, this could be any generic Windows system in your entire enterprise.

Launch the “F-Response Agent.MSI” to install the service locally on your system.

6. Start the F-Response Agent Service using your command prompt.

Launch an Administrator Command Prompt and use “sc” to start the service.

Programs
B cndexe
=, Open
B' CmDust =
“y Run as administrator h
Dacuments [ uyl =

tC:\NINDONS\system32>sc start "F-Response Agent Service”

Your output should look similar to the following:

C:\WINDOWS\system32>sc start "F-Response Agent Service"
SERVICE_NAME: F-Response Agent Servic
TYPE :

HIN3§ OWN_PROCESS

STATE : 2 START_PENDING
(NOT _STOPPABLE, NOT_PAUSABLE, IGNORES_SHUTDOWN)
WIN32 EXIT_CODE : 9 (Bx0)
SERVICE EXTT_CODE : @ (0@x0)
CHECKPOINT : Bx
WAIT_HINT : Bx7do
PID ¢ 3064
FLAGS
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7. Write down the IP address of the system you deployed the AGENT to by typing “ipconfig”

AGENT IP ADDRESS =

In this example, we are likely only using VMNETS.
8. OPTIONAL -> Using the Services GUI, start the “F-Response Agent Service.”

Right-click “Your System” and select “Manage.”

Manageh

Pin to Start

Show on Desktop
Map network drive...

Disconnect network drive...

85 Computer Management (Local |
o f} System Tools
(® Task Scheduler
» 3] Event Viewer
b @i] Shared Folders
» @8 Local Users and Groups
b Performance
2 Device Manager
4 % Storage
=¥ Disk Management
P f"ﬁ Services and Applications

ﬁ WMI Control
File Action \ﬁew—l;ieTp_ - o : - ) _
e = ; | U
Services (Local) || Name Description  Status Startup Type  Log On As
Family Safety This service ... Manual Local Service
Fax Enables you... Manual Network S...
File History Service Protects use... Manual (Tnig...  Local Syste...
FLEXnet Licensing Service This service ... Manual Local Syste...
‘G4 FLEXnet Licensing Service 64 This service ... Manual Local Syste...
k¥4 F_Response Agent Service F-Response -0l Running | Automatic Local Systeor,
% F-Response License Manager Service 1.12 Running  Manual Local Syste...
Z Function Discovery Provider Host The FDPHO... Running Manual Local Service
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Right-click and choose Start.

© 2016 Rob Lee

Start
Stop
Pause
Resume

Restart

All Tasks
Refresh
Properties

Help
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Exercise — Use SIFT Workstation to Connect to Remote System(s) You Have Deployed the Agent to and Started the
Service

1. Switch to your SIFT Workstation.

2. Loginto see the available nodes. (Note in this example that we are using the server IP, which on my
system is 192.168.112.1, but on your system, this should match the IP address that you deployed the
agent to.)

$ sudo su -

# f-response-accel-lin -n sansforensics —-p forensicsl234 -s
192.168.XXX.YYY

root@siftworkstation:/# f-response-accel-1in -n sansforensics -p forensics1234 -s 192.168.112.1
F-Response Acclerator - Linux Version 5.0.3

F-Response Acclerator for Linux requires Open-iSCSI.

Checking for Open-iSCSI utils now..

Ppen-iSCSI (iscsiadm) found.

Connecting to F-Response Target 192.168.112.1:3260...

Discovery Results.
F-Response Target = iqn.2008-02.com.f-response. jotumheim:disk-0
F-Response Target = 1qn.2008-02.com.f-response.jotumheim:vol-c
F-Response Target = 1qn.2008-02.com.f-response.jotumheim:pmem
Populating Open-iSCSI with node details..

ode information complete, adding authentication details.

3. Loginto remote hard drive target; usually Disk-0. Note in the preceding example, my system name was
jotumheim. The exact name of the system you are logging into will change for each system you are

oot@siftworkstation:/# f-response-accel-lin -1 iqn.2008-02.com.f-response. jotumheim:disk-0

-Response Acclerator - Linux Version 5.0.3

-Response Acclerator for Linux requires Open-iSCSI.

ogging in to [iface: default, target: iqn.2008-02.com.f-response.jotumheim:disk-8, portal: 192.168.112.1,3266]

ogin to [iface: default, target: ign.2008-82.com.f-response. jotumheim:disk-@, portal: 192.168.112.1,3260]: successful
QN:iqn.2008-02.com.f-response. jotumheim:disk-0 attached as /dev/sdc
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4. Run fdisk -l and examine output locating a new drive that is attached at /dev/sdc.

# fdisk -1

isk /dev/sdc; 512.1 GB, 512110196592 bytes

55 heads, 63%sectors/track, 62260 cylinders, total 1000215216 sectors
nits = sectofts of 1 * 512 = 512 bytes

ector size (ngical/physical): 512 bytes / 512 bytes

/0 size (minimum/optimal): 512 bytes / 512 bytes

isk identifier: 0x9ef8684e

Device Boot % Start End Blocks Id System
dev/sdcl * '-. 2048 718847 358400 7 HPFS/NTFS/exFAT
dev/sdc2 s 718848 1000212479 499746816 7 HPFS/NTFS/exFAT

Mount a larger partition vii. the SIFT Workstation using the mount command. (Note: /dev/sdc2 is what
it is on the example; your agtual results will vary depending on your system.) You can determine the

largest partition by examiniﬁ.g the partition with the largest number of blocks. Also, usually on Win7 and
later systems the 2nd partitign is the C:\ of the system.

A |
# imageMounter.py /dev/sdc /mnt/windows mount2

root@siftworkstation:/# imageMounter.py /dev/sdc /mnt/windows_mount2

[+] Creating Temp Mount Point at /mnt/windows_mount2/0

[+] Attempting to Mount Partition 0 at /mnt/windows_mount2/0
[-] Mounted /dev/sdc at /mnt/windows_mount2/0
[-] To unmount run 'sudo umount /mnt/windows_mount2/0'

[+] Creating Temp Mount Point at /mnt/windows_mount2/1

[+] Attempting to Mount Partition 1 at /mnt/windows_mount2/1
[-] Mounted /dev/sdc at /mnt/windows_mount2/1

[-] To unmount run 'sudo umount /mnt/windows_mount2/1'

6. Change directories to the /mnt/windows_mount2 directory and examine files. You should now be

able to see the files from the remote system with the F-Response Agent installed.

# cd /mnt/windows_mount2/1

# 1s

root@siftworkstation:/# cd /mnt/windows_mount2/1/
root@siftworkstation

© 2016 Rob Lee
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7. Change directories to the Windows/System32/config directory and extract the registry
contents of the SAM and SYSTEM hives. Please note that due to “lower/upper case conversions,” your
exact directory path might vary on your own system. You might need to use “tab complete” to help you
complete the directory path.

cd /mnt/windows _mount2/1
cd Windows/System32/config

rip.pl -r SAM ~f sam > /cases/sam.txt

H*= H = =

less /cases/sam.txt

root@siftworkstation:/mnt/windows_mount2/1# cd Windows/System32/config/
root@siftworkstation:/mnt/windows_mount2/1/Windows/System32/config# rip.pl -r SAM -f sam > /caseg
/sam.txt

Parsed Plugins file.

Launching samparse v.20120722

samparse complete.

root@siftworkstation:/mnt/windows_mount2/1/Windows/System32/config# less sam.txt

# rip.pl -r SYSTEM -f system > /cases/system.txt

# less /cases/system.txt
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Exercise — Attach Remote Memory

1. Loginto appropriate target; usually PMEM. Please note that it is a lowercase “L” in the £f-response-
accel-1in command. ?????? = your target system name.

Example (Memory) = ign.2008-02.com.f-response.?????:pmem

root@siftworkstation:/# f-response-accel-lin -1 ign.2008-02.com.f-response. jotumheim:pmem

-Response Acclerator - Linux Version 5.0.3

-Response Acclerator for Linux requires Open-iSCSI.

ogging in to [iface: default, target: iqn.2008-02.com.f-response.jotumheim:pmem, portal: 192.168.112.1,3260]

ogin to [iface: default, target: iqn.2008-02.com.f-response.jotumheim:pmem, portal: 192.168.112.1,3260]: successful
QN:1gn.2008-02.com.f-response. jotumheim:pmem attached as /dev/sdd .

2. Run fdisk -l and examine output locating the memory image. ¥4

a. It should not show a valid partition table at /dev/sdd.

# fdisk -1

Disk /dev/sdd: 9636 MB, 9636413440 bytes

64 heads, 32 sectors/track, 1148 cylinders, total 2352640 sectors
Units = sectors of 1 * 4096 = 4096 bytes

Sector size (logical/physical): 4096 bytes / 4096 bytes

I/0 size (minimum/optimal): 4096 bytes / 4096 bytes

Disk identifier: Ox00000000

Disk /dev/sdd doesn't contain a valid partition table

In the next section, you will learn how to use Volatility and Redline during memory analysis.

Some examples of commands we could run if connected over to memory on a remote system

View running processes # vol.py —-f /dev/sdd pslist
View open TCP network connections # vol.py —-f /dev/sdd connections
Recover Internet Explorer history from RAM # vol.py —-f /dev/sdd iehistory >

/cases/iehistory. txt
# less /cases/iehistory.txt
View registry hives present in memory # vol.py -f /dev/sdd hivelist
Parse Userassist key from RAM # vol.py -f /dev/sdd userassist >
/cases/userassist. txt
# less /cases/userassist.txt
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Exercise — Detach Remote F-Response Targets

1. Detach the remote target system memory and hard drives.

cd /
umount /mnt/windows_mount2/1

umount /mnt/windows_mount2/0

H#H= I = = F*
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Troubleshooting F-Response Enterprise

if you are having any problems using F-Response Enterprise, you might need to check this troubleshooting
guide.

1. Isthe F-Response Agent Service not starting correctly?

a. Ensure your F-Response Enterprise Dongle is inserted and you have started the F-Response
Enterprise License Manager.

b. Check your firewall. The firewall should be disabled or allow TCP ports 3260 and 5681 through.

c. Check the configuration options set in the preceding step 2 of “Creating a Remote Deployable
Agent” portion of this exercise. Re-create the .msi file if necessary.

2. Did you misconfigure the F-ResponseAgent.MSI and need to reconfigure/reinstall it?

a. Right-click F-ResponseAgent.msi file and click “uninstall.”

Install
Repair

_ Uninstall

b. Launch an Administrator Level “command prompt” and type the following: sc delete “F-
Response Agent Service.”

Programs
B cmd.exe
= Open
B CmDust :
R “¢ Run as administrator
| Administrator: C:\Windows\System32\cmd.exe

Microsoft Windows [Version 6.3.9608]
(c) 2013 Microsoft Corporation. All rights reserved.

C:\WINDOWS\system32>sc delete "F-Response Agent Service"
[SC] DeleteService SUCCESS

c. Reboot your system before starting over and installing a new .MSl file.
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Exercise Takeaways

Being able to connect to 100s of system in your environment to perform incident response is critical. Using a
deployable agent via group policy will allow you to connect to almost any IP address in your environment.

The next step is analysis and then making it automated, using a script to connect and pull specific data from
100s of systems in your enterprise.

The days of pulling a hard drive each time you want to analyze a system are over. The time to be able to
perform remote analysis is here, and using tools such as F-Response, Mandiant MIR, Encase Enterprise, and
many others gives you the ability to scale from a single system to thousands.
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Optional Exercise 2.1 — Redline Pre-Process

Objectives

1. Set up Mandiant Redline to conduct a memory audit in preparation for the memory analysis exercise.
2. If you do not want to complete this step, a pre-processed version of the memory image will be
provided in the next exercise.

Exercise Preparation

1. Install RedLine (Microsoft Windows-only tool).
e located onyour USB under \SIFT-Lab-Install\redline.
e Redline requires a recent version of the .NET framework, you might need to install .NET before the
installation. The install for the FULL version of .NET is found in \SIFT-Lab-Install\redline.

2. Execute Redline from the Windows Start menu (or equivalent).

3. Attach your FOR508 USB media and find the win7-32-nromanoff-memory-raw.00limage (it
should be located in win7-32-nromanof£f-10.3.58.5\win7-32-nromanoff-memory\).

4. Copythewin7-32-nromanoff-memory-raw.001 file to a local drive (i.e.
C:\Users\<username>\Desktop).

Exercise — Step-by-Step Guide

NOTE: Some older laptops and VM setups may take a very long time to process this memory image
(VMware Fusion is notoriously slow). If your system does not finish processing, a pre-processed analysis
file has been saved on your USB in the “win7-32-nromanof£f-10.3.58.5\win7-32-
nromanoff-c-drive\precooked\redline” folder. Instructions for loading the pre-processed
copy are present in the next exercise.

Perform a “Saved Memory File” analysis of the win7-32-nromanoff-memory-raw. 001 image.

1. Analyze data.
a. Select “From a Saved Memory File.”
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Redline’

Collect Data

Create a Standard Coliector >

Create an 10C Search Collector >

Analyze Data

Open Previous Analysis >

Create a Comprehensive Collector >

From a Saved Memory File > h

2. Find the "Location of Saved Memory Image” dialog.

Start your Ana_ly;::s Session |

image to aid in navigation and to
assist in the identification of
potential issues. Redline can also
search for Indicators of
Compromise {(described below) at
this time. If you wish to search for
Indicators of Compromise OCs)
at a later time, this option can be
found under the IOC reports tab.

n

Indicators of Compromise:

Indicators of Compromise are
forensic artifacts left behind by an
intrusion. An IOC file descnbes L=
these artifacts using the OpenlOC
format. When configuring an audit,
Redline verifies that the correct

data exists, or will be acquired, so

that these artifacts can be

e

Location of Saved Memory Image: Open Containing Folder

Browse...

Indicators of Compromise Location:

Browse...

" Cancel
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p— g—

g, e, —,

3. Browse tothe win7-32~-nromanoff-memory-raw.001 file.

a. You may need to select “All Files” on the drop-down to see the “.001” file extension.

Open X
«~ v A > This PC > Desktop . 1 & ¢ Search Desktop - P
Organize v Newfolder v @ @
To Read A Name Date modified Type Size &
3 This PC g win7-32-nromanoff-memory-..§ </9/2012 12228 Pt 001 Archive 2,097,132 KB
i 2 Desktop
@ Documents
JL Downloads
B Music
[&] Pictures v
& videos v < i >
File name: | win7-32-nromanoff-memory-raw Vl —Ail?iles " v
|Memoi lmaies ‘:

b. Leave “Indicators of Compromise Location” unchecked.
4. Click “Next” in the bottom right corner.
5. Select “Edit your script” to choose analysis options.

Start your Analysis Session

Review Script Configuration '

You have chosen to analyze a Saved Memory Image File

This will collect available data from a Saved Memory Image file and analyze it

Edit your script h

Please select a location where your data will be stored for future analysis
Save Your Analysis Session To:

Name: AnalysisSession

Location: C:\Users\Chad\Desktod] Browse
wa ] [ ok

© 2016 Rob Lee

Optional Exercise 2.1 — 3




6. Check “Strings” in both the Process Listing and Drivers Enumeration sections. Strings collection is one
of the most time intensive actions. Note that some options will be unavailable (greyed out), due to this
not being a live analysis. Click “OK.”

{1

i View and _Efii_t Your gafpt
Memory ‘ || Show Advanced Parameters
[¥] Process Listing 3
¥l Handles V] Ports
| 1] & sections
!i Imports Venty igital Signatures
Exports Detect Injected Sections
{41 Mds Shal
{71 sha2s6 MemD5
Drivers Enumeration
Imports Venfy Digital Signatures =
|| & Epors
, Md5 Sha
j| || Lshazse
| [¥! Hook Detection F
|} SSOT Index
I SSDT infine Drivers
J Venfy Digital Signatures
| |
Co ||

—_— = E = = = = b

7. Select “Save Your Analysis Session To.” Please rename_the save location to a directory and choose a
name you will remember. The name nromanof f-memory works fine, and you can save it to your
C:\Users\<username>\Desktop. Click “OK.”

Start your Analysis Session — O X

You have chosen to analyze a Saved Memory Image File

This will collect available data from a Saved Memory Image file and analyze it [

Edit your script ‘

— o |

Specify Analysis Session Location

Please select a location where your data will be stored for future analysis ‘
|
|

Save Your Analysis Session To:

Name: nromanoff-memory

Location: C:\Users\Chad\Desktop
Coe | [ ox |

8. Click through the Windows User Access Control (UAC) permission dialog if it appears.

9. When Redline completes processing, you will be ready to analyze datal
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Exercise 2.2 — Redline Memory Analysis

Objectives

1. Learn memory forensics using the prescribed memory analysis steps.

2. Gain experience using Redline to analyze data present in memory structures.
3. Witness the value of string searching in Windows processes.
4. Understand the pros and cons of live analysis collections.

Exercise Preparation

1. Install Redline (Microsoft Windows-only tool).
e located on your USB under \SIFT-Lab-Install\redline.
e Redline requires a recent version of the .NET framework; you might need to install .NET before the
installation. The install for the FULL version of .NET is found in \SIFT-Lab-Install\redline.

2. Perform a full memory audit of the win7-32-nromanoff-memory-raw. 001 image, including
process and driver strings output (see the “Optional Redline Pre-Process” exercise).

NOTE: Some older laptops and VM setups may take a very long time to process this memory image.
(VMware Fusion is notoriously slow.) If your system is still pre-processing at the start of this exercise,
cancel processing. A pre-processed analysis file has been saved on your USB in the “win7-32-
nromanoff-10.3.58.5\win7-32-nromanoff-c-drive\precooked\redline” folder.

3. If you are using the precooked image (i.e., you did not complete the “Optional Redline Pre-Process”
exercise), do the following:

e Copythe “win7-32-nromanof£f-10.3.58.5\win7-32-nromanoff-c-
drive\precooked\redline” folder from the course USB to a local drive. (Your desktop is
one good option.)

¢ Double-click the nromano££ .mans file located in the folder you just copied.

4. If for some reason double-clicking the nromano££ . mans file does not work, it can also be opened
directly via the “Open Previous Analysis” option on the main Redline menu.

© 2016 Rob Lee Exercise 2.2 -1



Redline’

Collect Data

Create a Standard Collector >
Create a Comprehensive Collector >

Create an I0C Search Coliector >

Analyze Data

From a Saved Memory File >

Open Previous Analysis > h

5. Mount your disk image so that you can interact with files and folders on the win7-32-nromanoff-c-
drive.

if your evidence is not already mounted in the SIFT workstation (from a previous exercise), you will need to
open a terminal in your SIFT workstation, elevate your privileges to root, and change to the /cases/
win7-32-nromanoff-c-drive directory. Then, uncompress and mount your evidence files so that you
can see the mounted filesystem in /mnt/windows_mount.

sudo su -

cd /cases/win7-32-nromanoff-c-drive /

mount -o ro,loop,show _sys files,streams interface=windows

$
#
# ewfmount win7-32-nromanoff-c-drive.E0l /mnt/ewf mount
# _Sys_
/mnt/ewf mount/ewfl /mnt/windows mount
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Exercise — Questions

1. Identify rogue processes.

e Review processes by MRI scores to identify any suspicious processes. What process has the
highest MRI score?

e  Why did the MRI score this process so high?

e What is the parent process?

e What user account (SID) was used to spawn the process?

e List the process binary path.

e Review the contents of the folder where this binary is located within the nromanoff disk
image (during the Exercise Preparation section you should have mounted nromanoff’s
disk image to /mnt/windows_mount).

What additional file is located in the same suspicious directory?

Open the newly discovered file in gedit (SIFT) or Notepad (Windows). What registry key
is referenced?

e View the hierarchical process list. Do you see any additional suspicious processes? (Ignore the
two junk processes with unusually large PID values -- they are false positives returned during
Redline’s executive process block carving.)
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2. Analyze Process DLLs and Handles.
e Review the “Handles” tab of each suspicious process identified in Question 1. Sort by the
“Occurrence” column to narrow your search using least frequency of occurrence (LFO) and
ignore any unnamed handles (no information present in Handle Name column).

e Review handles in PID 6404 and document the pointer to the interesting registry key
found in the last question.

e Focus on interesting file handles in PID 2956.

e List the loaded DLLs for each suspicious process by using the “Section” tab. Sort by the “Count”
column to narrow your search using least frequency of occurrence (LFO) and ignore any entries
with an empty “Section Name”.

e What DLL loaded by PID 1328 might make a good indicator?

3. Review network artifacts (select “Ports” in the Analysis Data pane).
¢ Do any network artifacts appear suspicious? What process spawned them?

4. Use the Redline “Strings” output to look for additional evidence.
e Search svchost.exe (PID 6404). Be creative. Terms such as “http://,” “https://,”
“ftp://,"“.exe,” “C:\,” and names of suspected malware or support files can
sometimes yield fruit.
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5. Optional homework: Create and run your own live analysis via a Redline Collector (NOTE: Redline
does not currently support Windows 10 collection and analysis).

a. Click the Top Left Icon “Create a Comprehensive Collector”.

2]

b. Edit

Redline®

Create a Standard Collector

Create a Comprehensive Collector

Create an 10C Search Collector

Analyze Collected Data

Analyze a Saved Memory File

Analyze this Computer

Open a Saved Analysis

= Optiors J] R bet Redine

your script.

i. Go through the various menus and select what you would like the script to collect. Because
we selected “Comprehensive Collector,” most options are already enabled. Any additional
selections will likely require a long time to complete.

ii. If you would also like the Collector to take a full memory image, select “Acquire Memory
Image.”

Re\new Script .(-Ilm—\ﬁ.gutation. .

You

)
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The comprehensive collector will gather mast of the data Redline is capable of collecting. Note: this will not coliect
strings which can be manually enabled by choosing to edit the script below.

Edit your script M

Acquire Memory Image

have chosen to create a Comprehensive Collector

Checking this option will acquire an image of memory that can be used to accurately acquire process memory and
drivers during analysis in Redline
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c. Specify Collector Location.

i. Place this on a USB thumb drive if you have one, or, for testing purposes you can save and
run the Collector from a local system drive.

" Speciy Collector Location”

1. Your Collector package will be created and saved to the location you specify below.

2. On the machine you want to audit, run the RunRedlineAudit.bat’ script, preferably from a removable media (e.g. 2
USB Fard Drive). This script will run the Collector as you configured it and save the results to a folder named "Audits’
next to the script.

3. When the collection is finished, transfer the results back to your analysis machine, and use the 'Analyze Collected
Data’ option on the start page or main menu,

A copy of these instructions can be found in the location you specified, in the file 'Readme.txt’

Save Your Collector To: QOpen Fo der \
| l Browse l

Collector Instructions 3

1. Your Collector package will be created and saved to the location you specify below.
2. On the machine you want to audit, run the 'RunRedlineAuditbat’ script, preferably from a
removable media (e.g. a USB Hard Drive). This script will run the Collector as you configured it

and save the results to a folder named "Audits’ next to the script.

3. When the collection is finished, transfer the results back to your analysis machine, and use the
"Analyze Collected Data’ option on the start page or main menu.

Choose from one of the options below or close this window to return to the start page:
Open Directory Containing Portable Package

A copy of these instructions can be found in the location you specified, in the file 'Readme.bet’

d. Open a command prompt with Administrator permissions on your target system and traverse to
the location of your Redline Collector. Execute the RunRedlineAudit.bat script. A new command shell
will be open, and you should see output from the Collectors being executed.
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.\Iemp\RedllneCo11ector>d1r
Uolume in drive D is Dat
Uolume Serial Number is 9250 D?B6

Directory of D:\Temp\RedlineCollector

98:29 <BIR> .
08:29 <DIR> .
B3:25 1,188 elevate.cnd
83:25 4,023 elevate.uvhs
H 1,778 finishAnalysis. js
839 getNextSessionFolder.js
Helper.hat
HemoryzeAuditScript.xml
Readme .txt
RunRedlinefudit.bat
1 x64
09/,18/2814 <DIR> x86
8 P11e(s) 16,589 hytes
4 Dircs) 155,.285,468,160 bytes free

:\Temp\RedlineCollector>RunRedlinefAudit.bat

[Executing command w32dr1uers—modu1e11st 1 4.46.9

Pre—execution diagnostics foxr command w32dr10ers-modu1e11st

PageFaultCount: 27842 PeaklorkingSetSize: 29382784 UHWorkingSetSize: 15917856 Quot
laPeakPagedPoolUsage: 243848 QuotaPagedPoolUsage: 221344 QuotaPeakNonPagedPoollUsa
l_eésgg§43 QuotaNonPagedPoolUsage: 16832 PagefilelUsage: 7688880 PeakPagefilelUsage
ComnitTotal: 2267418 CommitLimit: 4814297 CommitPeak: 2892849 Physicallotal: 419
1785 SystemCache: 265833 KernelTotal: 96689 KernelPaged: 63363 KernelNonpaged: 3
' 3246 PageSize: 4096 HandleCount: 46957 ProcessCount: 115 ThreadCount: 1428

' KIssue number='0" level="Info" summary='"System range Bx08890ABABAAABABE - OxBBHG
PBBRBNBA1808" context="EnumerateDevices"/>

Issue numher="8" level="Info" summary="System range Bx06008301606860608
PB0430600808" context="EnumerateDevices'/>

Bx0080
Issue number="8" level="Info" summary="System range Bx8008000000103009
BBBcFf65f0080" context="EnumerateDevices*/>

Issue number="0" level="Info" summary='"System range BxBDBOABABBO100680
PBBANP102688Y context="EnumerateDevices'/>

KIssue number="8" level="Info" summary="System range BxBB86BBBAANG1fEGEA
BABYBRAaBAAB" context="EnumerateDevices'/>

9x0008

0xB8690

8x060969

Issue number="17BB3“ leue}="lnfo" sunmar é"lnternal Informationflgorithm found Vv

i. A full collection script can take hours to run. (In the future, you can remove unnecessary
options in the audit script to speed up processing.) Your results will be located in a folder
named according to the System Hostname in the same location as your Collector.

(D:) » Temp » RedlineCollector » Sessions » AnalysisSessionT » Audits » M4500 » 20140918143212

A

Name Date modified Type Size

D w32drivers-modulelist.gmrE87wpBGdbV...  9/18/2014 8:37 AM  GMRESTWPBGDB... 80KB
D w32drivers-modulelist.issues.fGef3Dzm7...  9/18/2014 &:37 AM FGEF3DZM7KBDX... 2KB
|| w32drivers-signature.hjit2ZKUmjtYdZHbw... §/18/2014 835 AM  HITZ2KUMITYDZH... 1,033 KB
D w32drivers-signature.issues\P7KxpEMoo...  9/18/2014 &35 AM LP7KXPEMOOSCY... 42 KB
D w3Zkernel-hookdetection.eadoTX9SCRId... 9/18/2014 8:35 AM  EA4OTXSSCRIDRL.. 1KB
[ ] w32kernel-hookdetection.issues.kYwkVu...  9/18/2014 8:39 AM  KYWKVUXMIQED... 2KB
D w32processes-memory.issues.kPjBmfiGk... 9/18/2014 8:39 AM  KPJBMFIGKZSFLG... 0KB

© 2016 Rob Lee

Exercise 2.2 -7



e. Open your results in Redline and start your analysis.

i. <Top Left Icon> 2 Analyze Collected Data - Audit Location - <subfolder of folder named
according to System Hostname>. (Or just double-click the .mans file in the same folder.)

Redline®

!‘ Recent Analysis Sessions

Create a Standard Co ‘ector
Create a Comprehensive Collector

Create an I0C Search Col ector

Analyze Collected Data
Analyze a Saved Memory File

Analyze this Computer

 Open a Saved Analysis

Xt Rediine
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Exercise — Questions With Step-by-Step

1. Identify rogue processes.
e Review processes by MRI scores to identify any suspicious processes. What process has the
highest MRI score?

svchost.exe (PID 6404)
Redline® - D:\SANS\Memory images\SavedRedlineAudits\nromanoff\inromanoff.mans - a X |
.
r T
4 Processes In All Fields '
Handles " |
Memory Sections MRl Process Name MRI Score  PID Path Start Time |
Stnngs Y Y v Y Y Y H
Ports & swchostexe 97 6404 c\windows\system32dilhost  2012-04-06 19:22:20Z |
Hierarchical Processes R
9 A 61 3225496728 1601-01-01 00:00:002
Driver Modules .
Device Tree = (§A 61 3229591152 1601-01-01 00:00:00Z |
Hooks f,) csrss.exe 61 412 C:\Windows\system32 2012-04-04 11:47:412

e Why did the MR! score this process so high?
Double-click the process name and select “MRI Report.”

Answer: Unexpected location and unexpected arguments

-~

Y
w\.\’,;;v\"b

4

Al k“
550\\/0\“ (
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B3] Redline® - D:ASANS\Memory Images\SavedRedhneAudtts\momanoff\nromanoff mans

4 Processes

Fandles
Memory Sections
¢rings
Ports
Hierarchical Processes

Driver Modules
Device Tree
Hooks

Timeline
Tags and Comments

Acquisition History

@R\

A\ 4

Process Details

Username:

Path:

Parent:

Parent Process Path:
Arguments:

Start Time:

User Time Elapsed:
SID:

SID Type:
Malware Risk Index:

Kernel Time Elapsed:

svchost.exe

cwindows\system32\dilhost

PSEXESVC.EXE (2100)

C:\Windows
*c\windovws\system32\diihost\svchost.exe”
2012-04-06 19:22:202

00:00:08

00:00:01
$-1-5-21-2036804247-3058324640-2116585241- 1673

97

fﬁjr_. Home » Host » Processes » Full Detailed Information

Malware Risk Index Report

Expert Repart >

Malware Risk index Hits

4% This process was spawned from an unexpected location: “\windows\system32\dllhost™.

&P This process was spawned with unexpected arguments: “c:\windows\system32\dilhost
\svchost.exe™ "
Add Comment or Hit >
o Details !r Duplicate-s MRIReport | Sections } Handles ' Ports
y _ . : l
Host 10C Reports Strings |  Image Load Events _DNS Lookup Events | Network Events 1 File Write Events
Not Collected Registry Key Events I Process Events Exploit Events | URL Monitor Events i Tags and Comments
e What s the parent process?
PSEXESVC.EXE (PID 2100) -- aka “Sysinternals PsExec”
© 2016 Rob Lee Exercise 2.2 - 10




Redline® - D:\SANS\Memory images\SavedRedlineAudits\nromanoff\nromanoff.mans =

4 Processes
Handles
Memory Sections
Strings
Ports
Hierarchical Processes

Driver Modules
Device Tree
Hooks

Timeline

Acquisition History

ﬁi\
W

Process Details

Username:
Path:

' p- Parent:
Tags and Comments Parent Process Path:
Arguments:

Start Time:

Kernel Time Elapsed:

User Time Elapsed:
SID:

svchost.exe

c\windows\system32\dlthost

PSEXESVC.EXE {2100)

C\Windowss
“c\windows\system32\dilhost\svchost.exe®
2012-04-06 19:22:207

00:00:08

00:00-01
$-1-5-21-2036804247-3058324640-2116585241-1673

e What user account (SID) was used to spawn the process?

$-1-5-21-2036804247-3058324640-211658241-1673

%] Redline® - DASANS\Memory Images\SavedRediineAudits\nromanoffinromanoff.mans - '

n m Home » Host » Processes » Full Detailed Information

4 Processes
Handles
Memory Sections
Strings
Ports
Hierarchical Processes

Driver Modules
Device Tree
Hooks

Timeline
Tags and Comments

Acquisition History

(@R

A\ 4

Process Details

Username:
Path:
Parent:

Arguments:
Start Time:

Parent Process Path:

Kernel Time Elapsed:

svchost.exe

c\vandows\system32\dilhost

PSEXESVC.EXE {2100)

C:\Windows
*c\windows\system32\dithost\svchost.exe®
2012-04-06 19:22:20Z

00:00:08

00:00.01
S-1-5-21-2036804247-3058324640-2116585241-1673

User Time Elapsed:
* SID:

e List the process binary path.

c:\windows\system32\dllhost
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B2] Rediine® - DASANS\Memory lmages\SavedRedImeAudrts\nromanoff\nromanoff mans

a ﬁf. Home » Host » Processes » Full Detailed Information !

Malware Risk Index Report

4 Processes

Egri:wsn | @5 svchost.exe

Ports |
Hierarchical Processes

Driver Modules Process Details

Device Tree
Hooks Username:
# Path: c\windows\system32\dlithost
Timeline | Parent: PSEXESVC.EXE {2100)
Tags and Comments Parent Process Path:  C:\Windows
Arguments: “cwindows\system32\dithost\svchost.exe”

Acquisition History Start Time: 2012-04-06 19:22:207

Kernel Time Elapsed:  00:00:08
User Time Elapsed: 00:00:01
SID: S-1-5-21-2036804247-3058324640-2116585241-1673

e Review the contents of the folder where this binary is located within the nromanoff disk
image (during the Exercise Preparation section you should have mounted nromanoff’s
disk image to /mnt/windows_mount).

What additional file is located in the same suspicious directory?

winclient.reg

(< X0 rodt“@ﬁ‘iftworksta'tion: /mnt/windoWs_mount/Windows/SygtémBZ/dllhost
root@siftworkstation:/mnt/windows_mount/Windows/System32/dllhost# 11

total 741

drwxrwxrwx 1 root root 0 Apr 3 2012

drwxrwxrwx 1 root root 655360 Apr 6 2012

-rwXrwxrwx 1 root root 102400 Apr 14 2008 ex
STWXTWXrwx 2 root root 348 Apr 3 2012 t.reg*
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LT T S | dithost

- Home . Share View

L ,}é Cut >< L_:’:! ﬂ}}] New item v E
et w- Copy path te. > R o {'j Easy access v
Pinto Quick Copy Paste Move Copy Delete Rename New Propes
access [7] Paste shortcut 4o+ o~ - folder -
Clipboard Organize Mew
&« PN« SIFTWORKSTATION > mnt > windows_mount > Windows > System3Z2 > dilhost
D Music A Name R modified Type Size
=] Pictures (5] svchost ;“”3/13/2008 &12PM  Application 100 KB
B Videos &) winclient 47372012 5:41 PM Registration Entries 1KB

. Local Disk (C:)

Open the newly discovered file in gedit (SIFT) or Notepad (Windows). What registry key
is referenced?

HKLM\SYSTEM\CurrentControlSet\Services\Netman\domain

| winchent - Notepad - m} X
File Edit Format View Help

Windows Registry Editor Version 5.00

) - !0. -
"home"="http://12. 190.135.235/ads/"
"pause"”=dword: 00000040

If we believe svchost.exe is suspicious, the close proximity of winclient.reg also makes
it suspicious. Although we do not yet know the significance of the registry key and IP
address information stored within winclient.reg, they may later become useful
indicators of compromise.

e View the hierarchical process list. Do you see any additional suspicious processes? (Ignore the
two junk processes with unusually large PID values -- they are false positives returned during
Redline’s executive process block carving.)

spinlock.exe (PID 2956)
spinlock.exe (PID 1328)

Since both spinlock processes have the same PsExec parent as the suspicious svchost.exe
process, it would be prudent to look deeper into those processes. Open source research also
shows that spinlock.exe is not a common process name on Windows systems.
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. Redline® - D:\SANS\Memory Images\SavedRedlineAudits\nromancoffinromanoff.mans -
m Home » Host » Hierarchical Processes !
’ “{;’
| 4 Processes InAll Fields v | | Cear Cotumn Fiters
; Handles
| Memory Sections | R §> Process Name MRl Score  PID Path X
| trings 9/ HHTVIS.CAT - 108 AT IHUUNOASY LSS
| Ports a . y
| Hierarchical Procasses ), VMwareService.exe 47 1964 C:\Program Files\VMware\VMware Tot
| A AW o
| Driver Modules & » PSEXESVCEXE 47 2100 C:\Window:s
| DeviceTree &  » spinlockexe 47 2956 C:A\Windows\system32
Y
Hooks a
q) spinlock.exe 48 1328 C:\Windows\system32
| Timeline .
| Tags and Comments w svchost.exe 97 6404 c\windows\system32\dlihost -
Acquisition History L svchost.exe 47 2980 CAWindows\system32 15
I 2 )] Searchindexer.exe 47 3092 C\Windows\system32
X O OSPPSVC.EXE 47 4040 C:A\Program Files\Common Files\Micro «
Host 10C Reports ]-‘ = 4 L ; i
Not Collected . - - - _Sioil)_ggl_s ?? ftems i

2. Analyze Process DLLs and Handles.
e Review the “Handles” tab of each suspicious process identified in Question 1. Sort by the
“Occurrence” column to narrow your search using least frequency of occurrence (LFO) and
ignore any unnamed handles (no information present in Handle Name column).

e Review handles in PID 6404 and document the pointer to the interesting registry key
found in the last question.

svchost.exe (PID 6404):

The key REGISTRY\MACHINE\SYSTEM\CONTROLSET001\SERVICES\NETMAN\DOMAIN
has a low occurrence count. Recall that this is the same key we identified in step one,
referenced within the winclient.reg file.
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Redline® - DASANS\Memory Images\SavedRedlineAudits nromanoff\nromanoff.mans - 0 X

@Dv Home » Host » Hierarchical Processes » Full Detailed Information

t =psta & X OB : - ' e S B .
AnalysisData 4 ¥ P " nANRelds as \
4 Processes

Hand es Handle Name . Handle IYype Occur;ence
Memory Sections
Strings REGISTRY\USER\S-1-5-21-2036804247-3038324640-211658524 1-1673\SOFTWARE\WMICROSOF\WINDOW... Key 1
Ports . P
Hierarch cal Procasses REGISTRAMACHINE\SOFTWARE\MICROSOFT\TRACING\SVCHOST_RASAPI3Z\ Key i
Driver Modules REGISTRYAMACHINE\SOFTWARE\MICROSOFT\TRACING\SVCHOST_RASMANCS\ Key 1
gew;e Tree REGISTRY\USER\S-1-3-21-2036804247-3058324640-2116585241- 1673\SOFTWARE\MICROSOF \WINDOW..  Key 1
09|
OLES931AEC9B2B247CAACCD3FTFB003 ALPCPort 1
Timeline
Tags and Comments Service-0x0-d89e20$ WindowsStation 2
Acquisition History Service-0x0-d89e208 WindowsStation 2
REGISTRAMACHINE\SYSTEMACONTROLSETOOT\SERVICES\NETMAN\DOMAIN\ Key 2
REGISTRYAMACHINE\SYSTEMACONTROLSETOOT\SERVICES\NETMAN\DOMAINY Key 2
Onkngvn 3
clusersivibraniumlappdataliocalimicrosoftiwindoswvsitemporary internet fileslcontentia3! Unknown 2
. n Q - - v
host 10C Reports Deta s Duplicates MRI Report Sections Hand es Ports Stnngs Image Load Events DNS Lookup Events
Not Collected Network Events  File Write Events  Regustry Key Events  Process Events  Exploit Events  URL Monitor Events | Tags and Comments

e Focus on interesting file handles in PID 2956.

spinlock.exe (PID 2956):

\Device\NamedPipe\psexecsvc-WKS-WINXP32BIT-1952-stdin
\Device\NamedPipe\psexecsvc-WKS-WINXP32BIT-1952-stdout
\Device\NamedPipe\psexecsvc-WKS-WINXP32BIT-1952-stderr
\Device\NamedPipe\psexecsvc-WKS-WINXP32BIT-1628-stdin
\Device\NamedPipe\psexecsvc-WKS-WINXP32BIT-1628-stdout
\Device\NamedPipe\psexecsvc-WKS-WINXP32BIT-1628-stderr

Named pipes are a built-in way for processes to communicate with one another. They
can be used to communicate between processes on the same computer, or even
between two computers on a network. In this case, it looks like this pipe is named for
the PsExec service and also contains the hostname of a remote computer that
initiated the pipe (WKS-WINXP32BIT).
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Redline® - DASANS\Memory Images\SavedRedlineAudits\nromancff\nromancff.mans - w} X |

L T InAliFields

4 Processes

Handies |Hande Name o Handle TYype bccun;ence
Memory Sections
tnngs Device\NamedPipe\psexecsve-WKS-WINXP32BIT-1952-stdin File 2
e orocesses | |\Device\NamedPipe\psexecsvc-WKS-WINXPI2BIT-1952-stdout File 2 |
Driver Modules Device\NamedPipe\psexecsve-WKS-WINXP32BIT-1952-stderr File 2 I
g:‘:“; Tree \Device\NamedPipe\psexecsve-WKS-WINXP32BIT- 1628-stdin File 3
Timeline \Device\NamedPipe\psexecsve-WKS-WINXP32BIT-1628-stdout File 3
Tags and Comments Device\NamedPipe\psexecsve-WKS-WINXP32BIT-1628-stderr File 3
Acquisition History REGISTRY\USER\S- 1-5-21-2036804247-3058324620- 211658524 1- 1673\GOFTWARE\MICROSOFT\WINDOW... Key 5
!\Dew:e\HarddiskVqume‘I\Windmvs\SystemH\spinlock.exe File 7
Service-0x0-3027¢0% WindowsStation 8
|Service-0x0-3027¢0$ WindowsStation 8
I\Dewce HarddiskVolume 1\Windows\winsxs\x86_microsoft.windows.common-controls_6595664144ccfidi 5. File 10
" - \ -
Host 10C Reports Deta's Duplicates MRI Report Sections Hand'es Ports Sings image Load Events DNS Loo'p Events
Not Collected Network Events | File Write Evants = Registry Key Events | Process Events = Exploit Events = URL Monitor Events | Tags and Comments

|

e List the loaded DLLs for each suspicious process by using the “Section” tab. Sort by the “Count”
column to narrow your search using least frequency of occurrence (LFO) and ignore any entries
with an empty “Section Name”.

e What DLL loaded by PID 1328 might make a good indicator?

spinlock.exe (PID 1328):

\Device\HarddiskVolume1\Users\VIBRAN~1\AppData\Local\Temp\ MEI29562\
python25.dll

All three files loaded from the “AppData\Local\Temp” folder are interesting, and likely
indicate some sort of Python code being executed by this process. Since Python DLLs
are somewhat uncommon on standard user workstations, the presence of this DLL
might help identify variants of the spinlock malware. The MSVCR71.dll file is related,
but more commonly found on workstations (though not necessarily in the
“osUSERPROFILE%\AppData\Local\Temp” foider).
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Redline® - DASANS\Memory Images\SavedRedlineAudits\nromanoffinromanoff.mans |

4 Processes

H Section Name Count MD3 e
andles v Y b
Memory Sections
tnngs 0
Ports 0
Hierarch cal Processes
g M — e
Drwver Modules \Device\HarddiskVolume 1\Users\VIBRAN ~ \AppData\local\Temp\_MEI29562\python25.d1 1
Device Tree \Device\HarddiskVolume 1\Users\VIBRAN~ T\AppData\tocalTemp\_MEI29562\ ctypes.pyd 1
Hooks
\Device\HarddiskVolume 1\Users\VIBRAN~ 1\AppData\local\Temp\_MERISE2AMSVCR7 1.dll 1 k.
Timehne 1
Tags and Comments \Device\HarddiskVolume 1\Windows\System32\spinlock.exe 2
Acquisition History \Device\HarddiskVolume 1\Windows\System32\winrmm.dll 5
|\Device\HarddiskVolume 1\Windows\System32\urimon.dll 9
\Device\HarddiskVolume 1\Windows\System32\normahz.dil 9
\Device\HarddiskVolume 1\Windows\System32\iertutil.dil 9 [
Dev ce HarddiskVolume1\Windows\System32\w ninet.dll 9 '
m £ v
hitclicted ftem ltams
Host OC Re orts Deta's Duplicates MRI Report Sectons Hand es Ports Strings Image Load Events DNS Lookup Events
Not Collected e otk Events  File Write Events ~ Regstry Key Events = Process Events  Ex loit Events  URL Monitor Events = Tags and Comments

3. Review network artifacts (select “Ports” in the Analysis Data pane).
e Do any network artifacts appear suspicious? What process spawned them?

svchost.exe (PID 6404): 127.0.0.1:5678 to 127.0.0.1:62608 (localhost)

svchost.exe (PID 6404): 10.3.58.5:62567 to 10.3.58.255:80

spinlock.exe (PID 1328): 10.3.58.5:50817 to 199.73.28.114:443

The svchost.exe network activity is certainly strange, but difficult to understand without
reverse engineering the executable. The spinlock.exe connection looks like a classic beacon:
outbound connection to either port 80 or 443 from a process that should not be
communicating via HTTP or HTTPS.
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2] Redline® - D:ASANS\Memoty Images\SavedRedlineAudits) i\ ff.mans - 0 x

D:tﬁ x pel .:-‘ In &Nl Fields  ~ | Closs Cohomn Fifter
|
|  Processes PID  Path Process Name State Created Local IP Address  Local Port Remote IP Address Remote Port Prote *
4 Handles T h g v Y v v v v A
Hemory Secti:. 3

. ~,,9°;'y . T 564 cawindows\system32 services.exe LISTENING 0000000000, 49186 o Tcp

Ports O 592 cawindowsisystem32 isass.exe USTENING 000000:0000:... 48153 0 TP
Hietarchical Proc. -

_ ) 592 Cawindowsisystem32 Isassene LISTENING 2012-04-04 1148047 0000000000, 0 . 0 uoP
Drivar Modules -’ |
Device Tree 0 592 C\Windows\system32 Isass.exe LISTERING 2012-04-04 11:48:042 127001 55629 e 0 uor |
Facks Q 592 CAWindows\system32 Isass.exe CLOSED 10.3.585 62421 10.3.389 135 e :
Timeline o .
Tags and Comme C} 780  C\Windows\system32 svchostexe USTENIRG 00:00:00:00:00-.. 135 ] icp
Acquisition Histo T8t C\Windowsisystem32 wininiz.exe LISTENING 0000 49152 0 e

(} 7776 CA\Windows\system32 f-tesponse-entexe  ESTABLISHED 0.0.00 3260 10.3.16.5 48351 e
C‘\, 6404 c\vandows\system32\dithost svchostexe CLOSED 127.00 5678 127.00.1 62608 Tce ‘
Q 6404 c\windows\system32\dilhost svchostexe CLOSED 103585 62367 10.3.58.255 &0 e |
£
THi1328  cawindowsisystem32 spiniock exe CLOSED 103585 56817 199.7328.114 a3 P
{) 5176 C\Windows\system32 svchost.exe USTENING 2012-04-06 20:34:24Z 00.00 0 CH4 0 uop |
5 N (:‘) 1108 C\Windows\system32 taskhost.exe LISTENING 2012-02-04 14.45:462 127.00.3 49290 o 0 ube . |
Fost | 10C Reports 2 1 * |
Nt Collected O ShoviDensils  3Thems 3 ||

4. Use the Redline “Strings” output to look for additional evidence.
e Search svchost.exe (PID 6404). Be creative. Terms such as “http://,” “https://,”

“ftp://," “.exe,” “C:\,” and names of suspected malware or support files can
sometimes yield fruit.

Some interesting URIs can be found in the strings for the svchost.exe process:

http://12.190.135.235/ads

http://192.168.1.5/ads
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Redline® - DASANS\Memory Images\SavedRedlineAudits\nromanoffinromancff.mans - O X

N4 Home » Host » Processes » Full Detailed Information

Tags and Comments MoneyOhttp://moneycentral.msn.com/?0CID = MSNIEGJumplistZhttp://col.ste.s-msn.com/br/gbl Ig/est/faviconico
Lifestyle-http://lifestyle. msn.com/?0CID=MSNIESJumplistZhttp//col.ste.s-msn.com/br/gbl/lg/esl/favicon.co
http://12.190.135.235/ads/

http://192.168.1.5/ads/

Acquisition History

je t’ In All Fields Clear Column Filters l
Processes Strin ) |
ruerarchical Processes 9 Y '
T i VarA o o . = MY 8 o N B

Driver Modules ‘ ‘News REp7/vwav.msnbe.msn.com/ JOCTD=MSNIEWumphistShftp/vavwr.msnbec.msn.com/favicon.ico ‘

Device Tree | | Entertainment Thttp://entertainment.msn.com/?0CID=MSNIEQJumplist2hitpy/col ste.s-msn.com/br/gblfig/csl/faviconico |
Fooks

Sports-httpy//msn.foxsports.com/?0CID=MSNIEGJumphstShttp://msn foxsports.com/favicon.ico 1

Timehne !

|

I3 must begin wath PS5

http://12.190.135.235/ads/ |

ul

‘ <dpiAware xmlins="http//schemas.microsoft.com/ShI/2005/WindowsSettings” > true </dptAware> (U

http://Ss/%s -

« |

m | »

—— - !

ltems <)

| Stnngs Image Load Events DNS Lookup Events Network Events File Wnte Events
Host 10C Reports Registry Key Events Process Events Exploit Events URL Monitor Events Tags and Comments
Not Collected Details Duplicates MRI Report Sections Handles Ports
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5. Optional Homework: Create and run your own live analysis via a Redline Collector (NOTE: Redline
does not currently support Windows 10 collection and analysis).

1) <Top Left Icon> > Create a Comprehensive Collector

Redline®

Create a Standard Collector

Create a Comprehensive Collector

] Create an 10C Search Collector

Analyze Collected Data
Analyze a Saved Memory File

Analyze this Computer

- Open a Saved Analysis

3 Exit Redline

2) Edit your script:
a. Go through the various menus and select what you would like the script to collect. Because
we selected “Comprehensive Collector,” most options are already enabled. Any additional
selections will likely require a long time to complete.

b. If you would also like the collector to take a full memory image, select Acquire Memory
Image.

Review S_cript Configuration

You have chosen to create a Comprehensive Collector

The comprehensive collector will gather most of the data Redline is capable of collecting. Note: this will not collect
strings which can be manually enabled by choosing to edit the script below,

Edit your scrpt S

Acquire Memory Image

[ Checking this option will acquire an image of memory that can be used to accurately acquire process memory and
drivers during analysis in Redline
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3) Specify Collector Location
a. Place this on a USB thumb drive if you have one, or for testing purposes you can save and
run the collector from a local system drive.

e Cou;dm-l_ e “ e

1. Your Collector package will be created and saved to the location you specify below.
2. On the machine you want to audit, run the RunRedlineAudit.bat’ script, preferably from a removable media (e.g. 2 |
USB Hard Drive). This script will run the Collector as you configured it and save the results to a folder named 'Audits’

next to the script.

3. When the collection is finished, transfer the results back to your analysis machine, and use the ‘Analyze Collected |
Data’ option on the start page or main menu.

A copy of these instructions can be found in the location you specified in the file ‘Readme.tdt’

Save Your Collectosr To: Open Fo er N
y

Collector Instructions @

1. Your Collector package will be created and saved to the location you specify below.

2. On the machine you want to audit, run the 'RunRedlineAuditbat’ script, preferably from a
removable media (e.g. a USB Hard Drive). This script will run the Collector as you configured it
and save the results to a folder named 'Audits’ next to the script.

3. When the collection is finished, transfer the results back to your analysis machine, and use the
"Analyze Collected Data' option on the start page or main menu.

Choose from one of the options below or close this window to return to the start page:
( Open Directory Containing Portable Package

A copy of these instructions can be found in the location you specified, in the file 'Readme.txt’

" 4) Open a command prompt with Administrator permissions on your target system and traverse to
the location of your Redline Collector. Execute the RunRedlineAudit.bat script. A new command
shell will be open, and you should see output from the collectors being executed.
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.-::-"bli:»';{s isiratorn Commana

D:\Iemp\RedlineCollector>dir
Uolume in drive D is Da
Uolume Serial Number is 9253 D?B6

Directory of D:\Temp\RedlineCollector

0n9/18,2014 08:29 AM <DIR> S
@8:29 AM <DIR> oo
83: 25 P elevate.cnd
M elevate.vubs
PM ? finishfinalysis.js
PM getNextSessionFolder. js
PM Helper.bat
AN MemoryzefuditScript.xnl
PM Readme .txt
PM RunRedlinefludit.bat
19/18/2014 AN x64
B9/18,2814 aM <DIR> x86
8 Pile(s> 16,589 hytes
4 Dircs) 155.285.468.168 bytes free

:\Tenp\RedlineCollector>RunRedlinefiudit.bat

CiWindows\Sysiem

Executing command w32drivers—nmodulelist, 1.4.46.8

Pre—execution diagnostics for command w32dr1uers—modu1e11st

| PageFaultCount: 27842 PeaklorkingSetSize: 29382784 UWorkingSetSize: 15917856 Quot
laPeakPagedPoollUsage: 243848 QuotaPagedPoolUsage: 221344 QuotaPeakNonPagedPoollUsa
ueésgggéﬂ QuotaNonPagedPoolUsage: 16832 Pagefilelsage: 7680008 PeakPagefilelsage
ComnitTotal: 2267418 CommitLimit: 4814297 CommitPeak: 2892849 PhysicalTotal: 419
1785 SystemCache: 265833 KernelTotal: 96689 KernelPaged: 63363 KernelNonpaged: 3
3246 PageSize: 4896 HandleCount: 46957 ProcessCount: 115 ThreadCount: 1420
KIssue number="8" level="Info" summary="System range Ox6888000B0ACBB00A - BxBBBO
NBOV0NBBR1800" context="EnumerateDevices"/>

<Issue number="0" level="Info" summary="System range Bx0008800100808600 %0806
| 00430600008 context="EnumerateDevices*'/>

KIssue number="8" level="Info" summary="System range

Bx000000P0B0183000
NEPOcF65£808" context="EnumerateDevices'/>

B8x6069

4 I1ssue number="0" level="Info" summary="System range

: Bx060008800001 00088
::0@008192889" context="EnumerateDevices* />

9x0606

KIssue number="8" level="Info" summary=""System range BxPBBOOBBBEBAG1FBOO

Bx0ABO
P0P00RA9aBABY context="EnumerateDevices'/>

Informationfilgorithm

KIssue number="17083" level="Info' summary="Internal

a. A full collection script can take hours to run. (In the future you can remove unnecessary
options in the audit script to speed up processing.) Your results will be located in a folder
named according to the System Hostname in the same location as your collector.

(D:) » Temp » RedlineCollector » Sessions » AnalysisSessionl » Audits » M4500 » 20140918143212

»~

Name Date modified Type Size

|| w32drivers-modulelist.gmrE87wpBGdbV...  8/18/2014 8:37 AM  GMRESTWPBGDB... 80 KB
|| w32drivers-modulelist.issues.fGef3Dzm7...  9/18/2014 8&:37 AM  FGEF3DZMT7KBDX... 2KB
|| w32drivers-signature.hjlt2KUmjtYdZHbw...  9/18/2014 8:35 AM  HJITZKUMITYDZH... 1,033 KB
__| w32drivers-signature.issues.IP7KxpEMoo...  9/18/2014 8:35 AM  LP7KXPEMOOSCY... 42KB
|| w32kernel-hookdetection.eadoTX9SCRId... 9/18/2014 8:33 AM  EA4O0TX9SCRIDRI... 1KB
|| w32kernel-hookdetection.issues.kYwkVu...  9/18/2014 8:39 AM  KYWKVUXMIQED... 2KB
|| w32processes-memory.issues.kPjBmfiGk... 9/18/2014 8:39 AM  KPJBMFIGKZSFLG... 0K8
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5) Open your results in Redline and start your analysis:

© 2016 Rob Lee

a. <Top Left Icon> -2 Analyze Collected Data = Audit Location 2 <subfolder of folder named

according to System Hostname>. (Or just double click the .mans file in the same folder.)

Redline®

Create a Standard Collector

Create a Comprehensive Coliector

Create an 10C Search Collector

Analyze Collected Data

Analyze a Saved Memsr)&

Analyze this Computer

Open a Saved Analystis

= optioms J| 3 but Redline
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Exercise — Key Takeaways

Three suspicious binaries were identified:
o C:\windows\system32\dilhost\svchost.exe
o C:\windows\system32\spinlock.exe (two instances)

e lateral movement tradecraft found in the form of PsExec usage
o Process PSEXESVC.exe
o PsExec named pipes were identified in spinlock.exe handles referencing a remote system name
WKS-WINXP32BIT

e Aninteresting indicator for spinlock.exe was identified
o %USERPROFILE%\AppData\Local\Temp\python25.dli

e Asuspicious registry key was discovered within the winclient.reg file.
o MACHINE\SYSTEM\CONTROLSETOO1\SERVICES\NETMAN\DOMAIN

e Potentially malicious network connections were found:
o Several embedded strings for http://12.190.135.235/ads were found in the malicious
“svchost.exe” process.
o A suspicious connection to 199.73.28.114 from spinlock.exe was identified
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Exercise 2.3 - Volatility Memory Analysis

Objectives

1. Gain experience using Volatility to implement a memory forensics process.
Understand the various ways to display EPROCESS information.

Practice analyzing network connections found in memory.

Begin to employ “automation” and “baseline” plugins to find anomalies.

B wnN

Exercise Preparation

1. Please ensure your evidence is mounted correctly at /mnt/windows_mount; if not, please follow the
previous exercise “Mounting Evidence Using SIFT,” again to mount your evidence.

# cd /mnt/windows_mount

# 1s

root@siftworkstation:/mnt/windows_mount# 1s

RsGeackd
ssecure

If you do not see the above, then please follow directions in the Mounting Evidence Using SIFT exercise.

2. Change directory to the /cases/ win7-32-nromanoff-memory folder and make sure the win7-32-

nromanoff-memory-raw.001 memory image is present. (You should have previously copied it into your
SIFT Workstation VM)

# cd /cases/win7-32-nromanoff-memory/

# 1s -al
root@siftworkstation:/cases/win7-32-nromanoff-memory# 1s -al
total 2817304
drwxr-xr-x 3 root root 4096 Apr 17 21:48 .
drwxrwxrwx 9 root root 4096 Apr 14 21:39 1
drwxr-xr-x 2 root root 4096 Apr 17 21:47
“FWXr-Xr-x 1 root root 2147483648 Apr 14 22:01
fWesmen - 1 root root 1540 Apr 17 21:48 win7-32-nromanoff-memory-raw.txt
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Exercise — Questions

1. Image identification.
e Runthe imageinfo plugin against the win7-32-nromanoff-memory-raw.001 image.

# vol.py -f win7-32-nromanoff-memory-raw.001l imageinfo

i. When was the memory image created?

ii. Which profile should be specified when analyzing this image?

2. lIdentify rogue processes.
e Use the psscan plugin to scan the memory image for EPROCESS blocks. Do you see any
interesting process names that did not show up in Redline?

e What does the “Time exited” column mean from the psscan output?

e Use the pstree plugin to identify the parent of the suspicious svchost.exe (PID 6404) process.
What is its PID?

i. Do you see any other interesting processes with that parent we have not seen before?

ii. Keep reviewing the pstree output. Can you find another obviously suspicious block
of processes by visualizing their parent/child relationships?
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e Use the pstotal plugin to create a visualization graph of the processes.

# vol.py —f win7-32-nromanoff-memory-raw.001
--profile=Win7SP1x86 pstotal --cmd --output=dot --output-
file=/cases/win7-32-nromanoff-memory/memory-graph.dot

# dot -Tpng /cases/win7-32-nromanoff-memory/memory-graph.dot
-0 /cases/win7-32-nromanoff-memory/memory-graph.png

# xdot /cases/win7-32-nromanoff-memory/memory-graph.dot

Use the built in xdot tool to open the native memory-graph . dot file or browse to the
/cases/win7-32-nromanoff-memory directory, and double-click the file memory-
graph.png to view the graphic.

3. Analyze process DLLs and handles.

e Usethedlllist plugin to identify the full path and command line of the svchost.exe (PID=
6404) binary.

e Rungetsids on the svchost.exe (PID 6404) process to identify the primary token and user
account name used to start the process. (Note: This is a compromised account and should be
listed in our indicator list!)

i. What level of permissions does this account have?

ii. Extra credit: What other forensic artifacts could be used to validate the SID to account
name mapping performed by getsids?
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e Review process handles
i. Runthe handles plugin on the rogue svchost.exe process.

ii. Looking at the output, it should be clear why least frequency of occurrence is useful in
narrowing down items to analyze. Now narrow your view to just registry “Key” handles.
(Use the “-t Key” option.) Do you see a handle for the suspicious registry key previously
found in the Redline exercise?

4. Automate the search for anomalous system processes.
e Runmalsysproc to identify system processes with the wrong path, parent, command line,
number running (count), and so on. What processes are identified as anomalous? (Hint: Look
for columns that have “False” values.)

5. Review network artifacts.
e Runnetscan and review the output for suspicious connections.

e What connection is a good candidate for a malware beacon?

e Port 445 is used for SMB over IP traffic, and is commonly an indication of mounted file shares.
What IP addresses are connected to using this port?
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6. Optional homework: Use a baseline image to filter output.
You will find a baseline memory image for a SRL Win7SP1x86 system in the folder /cases/win7-
32-nromanocff-memory/baseline-memory. In this optional exercise we will use that baseline
image to help filter and whitelist large amounts of noise data.

Services
e Determine how many services are found in the win7-32-nromanoff-memory-raw.001
image using the svescan plugin, grep, and we.

# vol.py -f win7-32-nromanoff-memory-raw.001
--profile=Win7SP1x86 svcscan | grep “Service Name” | wc -1

e Use the baseline plugin servicebl with the —K (known) option to show services that exist in
both the current image and in the baseline. Review the output to get a feel for the format.

# vol.py —f win7-32-nromanoff-memory-raw.001
--profile=Win7SP1x86 -B ./baseline-
memory/Win7SP1x86-baseline.img servicebl -K

e Runthe same servicebl command using the —K option but now use grep to filter for
known services that are different from the baseline (contain “False” values in one or more
columns). How many services were found? Later, you can use svescan to review details for
each service in the nromanoff image and the baseline image.

# vol.py —f win7-32-nromanoff-memory-raw.001
--profile=Win7SP1x86 -B ./baseline-
memory/Win7SP1x86-baseline.img servicebl -K | grep False
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Exercise 6.2 - Win7 NFury10.3.58.6 PREP

Mount NFURY Windows 7 Image and Mount Multiple Volume Shadows

(Note: Some of this might already be accomplished via earlier exercises, but this is the state that we hope your system is in prior
to the start of this exercise. Just in case your system rebooted, we are including a guide to help you get back to the proper
analysis starting point prior to the beginning of this exercise.)

1. REBOOT your SIFT VMware Workstation in VMware Workstation.
2. Login to the VMware machine.
» LOGIN = sansforensics
» PASSWORD = forensics
3. Start a terminal, elevate your privs to root, and change to the /cases/win7-64-nfury-c-drive directory.

$ sudo su -

# cd /cases/win7-64-nfury-c-drive

4. Mount your evidence files so that you can see the win7-64-nfury-c-drive raw image and files/folders
from the system.

# ewfmount win7-64-nfury-c-drive.E0l /mnt/ewf mount/

# mountwin /mnt/ewf mount/ewfl /mnt/ windows mount

5. Mount raw image VSS using vshadowmount and mount all logical filesystems found in snapshot.

# vshadowmount /mnt/ewf mount/ewfl /mnt/vss
# cd /mnt/vss

# for i in vss*; do mountwin $i /mnt/shadow_mount/$i; done
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I Create Supertimeline across the core image and the VSS image

Create a VSS Supertimeline — Step-by-Step Guide

1. Run Log2timeline.py.

# cd /cases/win7-64-nfury-c-drive

# log2timeline.py —-parsers
“winevtx,filestat,winreg,webhist,lnk,prefetch” win7-64-nfury-
plaso.dump win7-64-nfury-c-drive.EO1l

Only include VSS snapshots 6,7

2. Filter using psort.py.

# psort.py -z "ESTS5EDT" -o L2tcsv win7-64-nfury-plaso.dump "date >
'2012-04-02 20:00:00' AND date < '2012-04-07 00:00:00'" >
nfury.timeline.csv

3. Switch over to your Windows Workstation (host system preferred) and open the \\SIFTWORKSTATION
from an open folder on your Desktop.

4. Take the filtered timeline and open it in Excel using the color-timeline template from your Windows
system.

a. Open Timeline Color Template:
i. TIMELINE COLOR_TEMPLATE. xlsx

@) TIMELINE_COLOR_TEMPLATE xIsx
=D TIMELINE_COLOR_TEMPLATE.zip

b. Switch to the Color Timeline worksheet/tab.
c. Click Cell A-1.
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' I= TIMELINE_COLOR_TEMPLATE.xdsx
Home Insert Page Layout Formulas Data Review View Add-ins
= bt Calibri 1l o A A= -:-_s D S Wrap Text General
2y Copy ~
Paste - - - . O BEEE = IE E | . - . o
s Eormat Painter I u S-A- EEE EE EMergeaCenter $ - %
Font P Alignment M Numtl
Al v S
A ] D E F G
1 ] -
2
3
4
5
I 6
= = ~
d. Select the “DATA” Ribbon.
e. Import Data "FROM TEXT."
IR | 5 TIMELINE_COLOR_TEMPLATEXisx
Home Insert Page Layout Formulas Data Review View Add-Ins
5 B &) @Connedions A _]7 ==
@ 8 -3 | =3 e ARV 25
From From Frolg From Other Existing Refresh ﬁl Sort Filter v Textto H
Access Web | Te Sources~  Connections | All~ A7 Advanced | Columns DI
ernal Data Connections sort & Filter
Al \v J
A B C D E F G
1| I
2
|

f.
c-drive.
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{&] Impost Text File

-@C}vr » Network » siftworkstation » cases » xp-tdungan-c-drive » ] I

Organize v New folder
5 SHIELD-USB (L) 4 Mame ’
QUTPUT (M:
- ) bulk-extractor-output
ecooked
€3 Network prece
keywords.txt
% ODOFFF1281E8-HO
" results.bt
;& 00OFFF12878F-HO &
= &) timeline.csv
&5 000FFF134537-C5
whitelist.txt

;13! 00OFFF136119-C7
&5 00DFFF136183-C7
& 000FFF1362C2.C7

xp-tdungan-c-drive.bd
xp-tdungan-c-drive_bodyfile.tat

g. The Text Import Wizard will start.
h. Step 1->Select Delimited -> Select NEXT.

Text Import Wizard - Step 1 of 3

The Text Wizard has determined that your data is Fixed Width,

1f this is correct, choose Next, or choose the data type that best desaribes your data.
Original data type
Choose the ﬁl:aw type that best desaribes your data:

rD_EﬂmL i . Characters such as commas or tabs separate each field.
O Fixed wi Fields are aligned in columns with spaces between each field.
Startimport atrow: 1 > File onigin: 437 : OEM United States E

Preview of file \\siftworkstation\cases\xp-tdungan-c-drive\timeline.csv.

1 Hatve,vime, vimezone, MACB, source, sourcetype, type,user, host, shexe,desc, vers] #
33/31/2003,07:00:00,351’5231‘, ...B,FILT, NIFS $MFT,$SY ({...B] time,-,WKS-WI
33/31/2003, 07:00:00,ESTSEDT M. .., FILE,NTFS $MFT,$SI [{M...] time,-,WKS-WI
D3/31/2003,07:00:00,2STSEDT, M. .., FILE NTFS $MFT,$SI (M...] time,-, WKS-WI

3/31/2003,07:00:00,ESTSEDT M. .., FILE NTFS $MFT,$SI [M...] time,-,WIKS-HI] ~

T »
[ concel [enextnen] (anshu)

i. Step 2->Unselect Tab under Delimiters -> Select Comma under Delimiters -> Select NEXT.
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I
Text Import Wizard - Step 2 of 3
This screen lets you set the defimiters your data contains. You can see how your textis affected in the preview
below.
Delimiters
[J1ab
] semicolon Treat consecutive delimiters as one
[7]iCommgg
.g"‘wM gualifier: | ° v
("] space
[Jather:
Data preview
ate Time cimezone MACB jgource jBourcetype fype sex &
03/31/2003 PP7:00:00 ESTSZDT |...B FILE FS SMFT BSI [...B] time ]
33/31/2003 P7:00:00 ESTSEZDT ... FILE TTES $MEFT [BSI [M...] time 7
33/31/2003 P7:00:00 ESTS5ZDT ... FILZ FS $MET SI [M...] time ]
D3/31/2003 P7:00:00 ESTSEDT ... FIiL= IIFS $MET SI [M...] time 7y
< 3
| caxel || <Bak || wmext> || mEnish |

j- Step 3 ->Select Finish.
k. Where do you want to put the data? Simply Select OK.

Import Data L? liri&'i

Where do you want to put the data?
Q) Existing worksheet:

=SAS1
New worksheet

Propertes... oK Cancel

I.  When imported View -> Freeze Panes -> Freeze Top Row.
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H
Save
Workspace §

e
bW View Add-Ins
© | : PR @ f Eg (B split . 1) View Side by Side
A\ = ) | ™™ Hide chronous Scro
Zoom 100% Zoomto New Arrange Freeze =
Selection Window  All  |Panes~ Bun #dReseiy
___Zoom_ n - ) Unfreeze Panes
Eg Unlock all rows and columns to scroll
through the entire worksheet.
Freeze Top Row
E% Keep the top row visible while scroiling
— —— . through the rest of the worksheet.
F _ E:@ Freeze First Column
~i=izi  Keep the first column visible while scrolling
rcetype type through the rest of the worksheet.
ES SMFT $S!I[...B] time

m. Optional Hide Columns Time Zone, Host, Version.

C D E
$ Cut
2y co —
ESTS =2 Lopy
c @ Paste Options:
|
)
Paste Speaal...
Insert
Delete
Ciear Contents
%f Format Cells...
Column Width...
Hide
Unhide
|
n. Select the HOME tab on the Ribbon.
KNH9-&-|s
| File_1. Home Insert Page Lay
| —
& Ccut Catibri
i &3 Copy -
aste -
- J Format Painter £ U
pasubbasd. s J

o. Select All Cells or "CTRL-A."

© 2016 Rob Lee

Exercise 6.2-6



p. In Home Ribbon -> Sort and Filter -> Filter and you will be ready to begin analysis.

[ AutoSum ~ %F @E

) Fint -
Sort & iFind &
P Clear~  |Fitter v | Select ~

R 21 Sort Smallest to Largest

%1 sort Largest to Smallest

Custom Sort...

Filter

1

|

Clear

&
Yg Reapp

g. Before you analyze too much, please save your new Color Timeline as an XLSX file:
/cases/win7-64-nfury-c-drive/vss-supertimeline.xlsx
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Exercise 6.3 XP TDUNGAN 10.3.58.7 PREP

Mount NROMANOFF Windows 7 Image and Mount Multiple Volume Shadows

(Note: Some of this might already be accomplished via earlier exercises, but this is the state that we hope your system is in prior
to the start of this exercise. Just in case your system rebooted, we are including a guide to help you get back to the proper
analysis starting point prior to the beginning of this exercise.)

1. REBOOT your SIFT VMware Workstation in VMware Workstation.
2. Login to the VMware machine.

» LOGIN = sansforensics

» PASSWORD = forensics
3. Start a terminal, elevate your privs to root, and change in the /cases/win7-c-drive directory.

$ sudo su -

# cd /cases/xp-tdungan-c-drive

4. Mount your evidence files so that you can see the xp-tdungan-c-drive raw image and files/folders from
the system.

# ewfmount xp-tdungan-c-drive.E0l /mnt/ewf mount/

# mountwin /mnt/ewf mount/ewfl /mnt/windows mount
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l Create Supertimeline across the core image and the VSS image

Create a VSS Supertimeline — Step-by-Step Guide

1. Run Log2timeline.

# cd /cases/xp-tdungan-c-drive

# log2timeline.py xp-tdungan-plaso.dump xp-tdungan-c-drive.EOl

2. Filter using psort.py.

# psort.py -z "ESTS5EDT" -o L2tcsv xp-tdungan-plaso.dump
"date > '2012-04-02 20:00:00' AND date < '2012-04-07 00:00:00'" >

tdungan. timeline.csv

Switch to your Windows workstation (host system preferred) and open the \\SIFTWORKSTATION from
an open folder on your Desktop.

3. Take the filtered timeline and open it in Excel using the color-timeline template from your Windows

system.
a. Open Timeline Color Template: TIMELINE COLOR TEMPLATE.xlsx.

) TIMELINE_COLOR_TEMPLATE xisx
TIMELINE_COLOR_TEMPLATE.zip

b. Switch to Color Timeline worksheet/tab.
c. Click Cell A-1.
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j~ M - |= TIMELINE_COLOR_TEMPLATE.xlst

Home Insert Page Layout Formulas Data Review View Add-ins

1 J‘QCut Calibri 1l A A = EE._;:.—] S Sj Wrap Text General
Paste e B Z U~ i~ &-A- EEE EE EdMergeCenter~ § + 9
« 7 Format Painter = — s S L g¢ & Lenter by
Chpboard . S— Font_ : - , Alignment _ “ Mumiy
Al - s | - |
L 4] A B C D E F G
1 | |
2
3
4
5
| 6
-
d. Select “DATA” on the Ribbon.
e. Import Data "FROM TEXT."
v TIMELINE_COLOR_TEMPLATE.xlsx
Home Insert Page Layout Formulas Data Review View Add-Ins
: : L] Connections - V& =
% '—'@ % @ {1 Properties 2‘ 2 ﬁ .j Z Et—r_,
From From  Frolg From Other Existing Refresh . ﬁl Sort Filter v Text to
Access Web Te& Sources*  Connections | All~ &2 Edit Links .7 Advanced | Columns D
al Data Sort & Filter
Al \v Jx
Ve RO G D F G
1
2_ g

f. Selectnromaoff.timeline.csvfile->\\siftworkstation\cases\xp-tdungan-
c-drive.
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(] Import Text Fite

— @| . » Network » sftworkstation » cases » xp-tdungan-c-drive » = I
o
Organize v New folder
¢y SHIELD-USB (L2} -
QUTPUT (M:]
= . bulk-extractor-output
?9 Network :recao:edm
0rgs.|
$&5 00OFFF1281EB-HO ;ywm o
i results.
. ;%% 0DOFFF12878F-HO @u :
| {8 0OFFFI3IS37-C5 meline.csv
! whitelist.txt

18 000FFF136119-C7
;&% Q0OFFF1361B3-C7
% O00FFF1362€2-C7

. Xp-tdungan-c-drive.txt
xp-tdungan-c-drive_bodyfile.txt

g. The Text Import Wizard will start.
h. Step 1 ->Select Delimited -> Select NEXT.

—_— . e
Text Import Wizard - Step 1 of 3 -2 |i=E3u

The Text Wizard has determined that your data is Fixed Width,
If this is correct, choose Next, or choose the data type that best descaribes your data.
Original data type

- Characters such as commas or tabs separate each field.

Fixed wi Fields are aligned in columns with spaces between each field. |
Startimportatrow: 1 < File onigin: 437 : OEM United States v
Preview of file \\siftworkstation\cases\xp-tdungan-c-dnive\timelne.csv. I

1 Hate, time, timezone, MACB, source, sourcetype, type,user, host, short,desc, vers] 4
33/31/2003, 07:00:00,EZ8TSEDT, ...B,FILE, NTFS $MFT,$SI (...B] time,~,WKS-WI
D3/31/2003,07:00:00,ESTSEDT , M. .., FILE,NIFS $MrT,s$SI (M...] time,~,WKS-WI
03/31/2003,07:00:00,28TSZDT, M. .., FILE NTFS $MFT,$SI [M...] time, -, WKS-WI

B 3/31/2008,07:00:00,SSTSEDT, M. .., FILE NTIFS $MFT,$SI [M...] time,-,WKS-WI§ ~
] it} »

(oo ) (o

h ==

i. Step 2->Unselect Tab under Delimiters -> Select Comma under Delimiters -> Select NEXT >.
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e ———————
Text Import Wizard - Step 2 of 3
This saeen lets you set the delimiters your data contains. You can see how your text is affected in the preview
below.
§ Delimiters
[TJ1ab
7] semicolon " Treat consecutive delimiters as one
— gualifier: v
(] space
[ other: |
Data preview
| ate Time cimezone MAC3 ouzcetype [ype sex -~
33/31/2003 P7:00:00 ESTSEZDT [...B FS $MFT $3SI ([...B] time 7
D3/31/2003 P7:00:00 ESTSZDT B FS $MET SI [M...] time 1
D3/31/2003 P7:00:00 ESTSZDT £... FS sMFT SI [M...] time T
D3/31/2003 07:00:00 ESTSEDT TFS SMFT SI [M...] time 13 -
¢ m »

j.
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Step 3 ->Select Finish.
k. Where do you want to put the data? Simply Select OK.

Import Data

Q' Existing worksheet:
=SAS1
New worksheet

L2 =)

Where do you want to put the data?

P

[_i;gbperhes...*] r OK

J [ concel |

When imported View -> Freeze Panes -> Freeze Top Row.
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e
B View Add-Ins
; S o o I
g = HEE =
e ™= Hide ) e
Zoom 100% Zoomto New  Arrange Freeze
Selection | Window  All  |Panes~ 24 Reset Workspace
Unfreeze Panes
n rows and columns to scroll
t he entire worksheet.
Freeze Top Row
Kee op row visible while scrolling
t he rest of the worksheet.
F Freeze First Column
Kee irst column visible while scrolling
rcetype type t he rest of the worksheet.
S SMFT $SI[...B] time

m. Optional Hide Columns Time Zone, Host, Version.

¢ 53 Copy
Paste Options:

.

Paste Speaal...

Insert
Delete

Clear Contents

@ Format Cells...
Column Width...

Hide
Unhide
| ]
n. Select HOME on the Ribbon.
Kdg-o-s
Home Insert Page Lay
&'.
% cut Calibri
oot =2 Copy ~
aste .
« - Format Painter £ U
. _;Irpb{_:-.arg a

0. Select all Cells or "CTRL-A."
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p. In Home Ribbon -> Sort and Filter -> Filter and you will be ready to begin analysis.

[ AutoSum ~ %‘F }3

) Fitt ~
Sort & iFind &
P Clear ~ Filter v |Select ~

§ 21 Sort Smallest to Largest
%l ~ Sort Largest to Smallest
Custom Sort...

Filter

Clear

@Mé% &

Reapply

g. Before you analyze too much, please save your new Color Timeline as an XLSX file:
/cases/xp-tdungan-c-drive/vss-supertimeline.xlsx
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Exercise 6.4 win2008R2-controller 10.3.58.4 PREP

Mount win2008R2-Controller Image

(Note: Some of this might already be accomplished via earlier exercises, but this is the state that we hope your system is in prior
to the start of this exercise. Just in case your system rebooted, we are including a guide to help you get back to the proper
analysis starting point prior to the beginning of this exercise.)

1. REBOOT your SIFT VMware Workstation in VMware Workstation.
2. Login the VMware machine.
» LOGIN = sansforensics
» PASSWORD = forensics
3. Start a terminal, elevate your privs to root, and change into the /cases/win2008R2-controller-c-
drivedirectory.

$ sudo su -

# cd /cases/win2008R2-controller-c-drive

4. Mount your evidence files so you can see the win2008R2-controller-c-driveraw image and files/folders
from the system.

# ewfmount win2008R2-controller-c-drive.E01 /mnt/ewf/

# mountwin /mnt/ewf/ewfl /mnt/windows mount
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I Create SuperTimeline of MFT hive data across the core image and the VSS image

Create a SuperTimeline — Step-by-Step Guide

1. Step 1-Run Log2timeline.py

# cd /cases/win2008R2-controller-c-drive

# log2timeline.py —-parsers
“winevtx,filestat,winreg,webhist,lnk,prefetch” win2008-dc-plaso.dump
win2008R2-controller-c~-drive.EO1

Do Not Include Any Snapshots

2. Filter using psort.py

# psort.py -z "ESTSEDT" -o L2tcsv win2008-dc-plaso.dump
"date > '2012-04-02 20:00:00' AND date < '2012-04-07 00:00:00'" >

2008dc.timeline.csv

3. Switch over to your Windows Workstation (Host System Preferred) and open the \\SIFTWORKSTATION
from an open folder on your Desktop.

4. Take the filtered timeline and open it up in Excel using the color-timeline template from your windows
system.

a. Open Timeline Color Template
i. TIMELINE COLOR_ TEMPLATE. xlsx

&) TIMELINE_COLOR_TEMPLATE xlsx
) TIMELINE_COLOR_TEMPLATE zip

b. Switch to Color Timeline worksheet/tab.
c. Click on Cell A-1.
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c

TIMELINE_COLOR_TEMPLATExlsx

_ Home Insert Page Layout Formulas Data Review View Add-Ins
b Cut Calibri 1l r A A= EE_EH B~ =5 Wrap Text General
Past 33 Copy ~ Oy A R
aste . - v e EEE ESsE L & . . 9
- < Format Painter B 7 U EH A- EEE EE EMerge & Center $ o
Clipboard « Font * Alignment - Mumt
Al v Jx
| A | 8 C D E F G
| 1 | I
2 I
3
4
5
6
; e ——.
d. Select 'DATA' Ribbon.
e. Import Data "FROM TEXT".
;‘_(]l = | = v = TIMELINE_COLOR_TEMPLATE.xisx
Home insert Page Layout Formutas Data Review View Add-Ins
X RN By L] % (@) connections | BT 4 =
i F < < ¢
@I =@ =0 = =13 S o perties ARV N Ee=
From From Frolg From Other Existing Refresh ﬁl Sort Filter v Text to
Access Web | Te Sources -  Connections | All~ '~ Edit Links .7 Advanced | Columns D
al Data
| Al v Sx
Lig| W= B C D E F
1 | I
2
—— =

Select 2008dc. timeline.csvfile->
\\siftworkstation\cases\win2008R2-controller-c-drive
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h.
i

(] import Text File

@C)'l L. » Network » siftworkstation » cases » xp-tdungan-c-drive »

Organize ~ New foldes
(s SHIELD-USB (L)
OUTPUT (M:
Lo M bulk-extractor-output
recooked
€1z Network \F
= _i keywords.txt
& 000FFFL281E8-HO
. results.tt
;¥ 000FFF12878F-HO
- @ timeline.csy
& 000FFF134537-C5
whitelist.bt

;85 000FFF136119-CT
&% O0OFFF136183-C7
g. M GOOFFF1362C2-C7

xp-tdungan-c-dnve.bt
xp-tdungan-c-dnive_bodyfile.txt

v | 4y | | Searth 121

TEXT IMPORT WIZARD Wili Start.
Step 1 -> Select Delimited -> Select NEXT.

© 2016 Rob Lee

Text Import Wizard - Step 1 of 3

The Text Wizard has determined that your data is Fixed \Width.
1f this is correct, choose Next, or choose the data type that best describes your data.

Original data type
Choose the file type that best descnibes your data:
© Delimi ! . Characters such as commas or tabs separate each field.

O Fixed wi Fields are aligned in columns with spaces between each field.

Startimportatrow: |1 % File origin: 437 : OEM United States

Preview of file \\siftworkstation\cases\xp-tdungan-c-drive\timeline.csv.

EAE

1 Hate, time, timezone, MACB, source, sourcetype, type,user, host, short,desc, vexrs] ©

3/31/2003,07:00:00,5ST3EDT, ...B,FILE NTFS $MFT,$ST (...B)
03/31/2003,07:00:00,ESTSEDT, M. . ., FILE, NIFS $MFT,$SI (M...]
3/31/2003,07:00:00,8STSEDT, M. .., FILE, NTFS SMFT,$SI (M...]
03/31/2003,07:00:00,Z8TSEDT, M. .., FILE, NTFS $MET,$5I (M...]

< n

time, -, WKS-HI

time, -, WKS-HI

time, -, WKS-HI

time, -, WKS-HIY ~
)

_ Concel | [ dext> J[ emsh |
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Je

Step 2 -> Unselect Tab under Delimiters -> Select Comma under Delimiters -> Select NEXT >

_—
Text Import Wizard - Step 2 of 3 [ 2 =3
This screen lets you set the delimiters your data contains. You can see how your text is affected in the preview
below.
Delimiters
Tab
Semicolo Treat consecutive delimiters as one
Com
it Mguahﬁen - v
Space
Other:
Data preview
ate Time cimezone MACS ouzcetype kype sex o
D3/31/2003 P7:00:00 ESTSEDT [...B FS $MFT KSI [...B] time o
33/31/2003 PN7:00:00 ESTSEZDT IIES $MET BSI (M...] time 03
33/31/2003 P7:00:00 ESTSZDT IITFS S$MET SI [M...} time 7
23/31/2003 PN7:00:00 ESTSEDT FS $MFT PBSTI [M...] time 13 -
< »
Cancel ][ < Back ][ Next > ][ Finish 1

k.
l.
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Step 3 ->Select Finish.
Where do you want to put the data? Simply Select OK.

Import Data

Where do you want to put the data?
0 Existing worksheet:

=SAS1
New worksheet

2%
b}

[Pg_opefbes] [ oK ] [ Cancel J
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m. Once imported View -> Freeze Panes -> Freeze Top Row.

{ .“5\;

F
lrcetype

S SMFT

By View

100

Zoom 100% Zoomto

Add-Ins

‘type

New Arrange|Freeze
Selection | Window Al {Panes~

E Unfreeze Panes
E Unlock ail rows and columns to scroll

through the entire worksheet,

Freeze Top Row
@ Keep the top row visible while scrolling

= Hide

] split Y View Side by Side

T

Save
Workspace

through the rest of the worksheet.

Freeze First Column
‘;% Keep the first column visible while scrolling

through the rest of the worksheet,

1$S1[...B] time

n. Optional Hide Columns Time Zone, Host, Version.

0. Select HOME Ribbon.
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ESTE &
e

ESTS

ESTE? Paste Special...
: .

ESTS  Insert

ESTEl Delete

ESTE}’ Clear Contents

ESTS % Format Cells...
ESTE Column Width...

ESTS  Hide
ESTE Unhide
]

File Home Insert Page Lay
= ¥ cut

_J Calibri
133 Copy -
Paste .
» < Format Painter 7 U
Clipbosra
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p. Select all Cells "CTRL-A".

g. In Home Ribbon -> Sort and Filter — Filter and you will be ready to begin analysis.

tosum v | A @
; yAl

Sort & Find &
p Clear ~ Filter v |Select v

1 Sort Smallest to Largest
Sort Largest to Smallest

Custom Sort...

Filter

r. Before you analyze too much — please save your new Color Timeline as an XLSX file: /cases/
win2008R2-controller-c-drive/supertimeline.xlsx
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